Welcome to SKED 3.1, the ultimate software tool for managing PMS schedules. SKED 3.1 implements years of Fleet feedback, and revolutionizes the way maintenance is performed and documented across the Fleet.

USING THIS GUIDE

This user guide serves two purposes. The first purpose is to act as a learning tool and reference for Workcenter Supervisors who want to learn how to perform all of the relevant functions in SKED 3.1. The other purpose is to go beyond the “button-clicking” mentality, and to understand how, why and when certain SKED functions are performed.

To satisfy both purposes, this user guide can be divided into two sections. The first section, Chapters 1-4, takes you on a journey from when SKED is first installed on a ship that is being overhauled, all the way to when the cycle is restarted. This way, there is a context in which all the functions occur and hopefully will contribute to a deeper understanding of how SKED works. The second section, Chapters 5-12, largely covers the new features of SKED 3.1. You can quickly get up to speed on the latest improvements version 3.1 has to offer. You will learn all the benefits of the new features, as well as how to use them.

Throughout the user’s guide, you will see icons for the 3M Coordinator and the Department Head. When these appear next to topics, it indicates that the 3MC and DH are responsible for performing the tasks that are being discussed.

Contact Information

Mike Manlove
757.547.2828
mmanlove@antechsystems.com

SKED 3.1
www.antechsystems.com/sked31.htm
sked@antechsystems.com
<table>
<thead>
<tr>
<th>CHAPTER 3: MAINTAIN QUARTER</th>
<th>UNDERSTANDING MAINTENANCE MODE</th>
<th>28</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>UNDERSTANDING WORKCENTER OPTIONS</td>
<td>28</td>
</tr>
<tr>
<td></td>
<td>MARKING THE BOARDS</td>
<td>29</td>
</tr>
<tr>
<td></td>
<td>VIEWING CHECK &amp; ROW PROPERTIES</td>
<td>30</td>
</tr>
<tr>
<td></td>
<td>CREATING FLIP PAGE ENTRIES</td>
<td>32</td>
</tr>
<tr>
<td></td>
<td>BINDING CHECKS</td>
<td>32</td>
</tr>
<tr>
<td></td>
<td>UPDATING SPOT CHECKS RESULTS</td>
<td>33</td>
</tr>
<tr>
<td></td>
<td>GENERATING WORK CANDIDATES</td>
<td>33</td>
</tr>
<tr>
<td></td>
<td>INTRODUCING R-CHECKS</td>
<td>34</td>
</tr>
<tr>
<td></td>
<td>PERFORMING BACKUPS</td>
<td>34</td>
</tr>
<tr>
<td></td>
<td>ADDITIONAL RESOURCES</td>
<td>35</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>CHAPTER 4: GENERATE NEW QUARTERS</th>
<th>UNDERSTANDING HOW SKED CYCLES CONTINUE OVER TIME</th>
<th>38</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>GENERATING NEW QUARTERS</td>
<td>39</td>
</tr>
<tr>
<td></td>
<td>RETURNING QUARTERS TO REVISE MODE</td>
<td>39</td>
</tr>
<tr>
<td></td>
<td>PERFORMING REVISIONS</td>
<td>39</td>
</tr>
<tr>
<td></td>
<td>Using the Revision Wizard</td>
<td>40</td>
</tr>
<tr>
<td></td>
<td>Using the Revision Editor</td>
<td>41</td>
</tr>
<tr>
<td></td>
<td>FINALIZING THE REVISION</td>
<td>44</td>
</tr>
<tr>
<td></td>
<td>ADDITIONAL RESOURCES</td>
<td>45</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>CHAPTER 5: FORCE REVISION</th>
<th>UNDERSTANDING FORCE REVISION</th>
<th>48</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Using the Revision Changes Notification</td>
<td>48</td>
</tr>
<tr>
<td></td>
<td>Using the Revision Wizard</td>
<td>49</td>
</tr>
<tr>
<td></td>
<td>Using the Revision Editor</td>
<td>50</td>
</tr>
<tr>
<td></td>
<td>FINALIZING THE FORCE REVISION</td>
<td>53</td>
</tr>
<tr>
<td></td>
<td>ADDITIONAL RESOURCES</td>
<td>54</td>
</tr>
</tbody>
</table>
## CHAPTER 6: R-CHECKS

UNDERSTANDING R-CHECKS ........................................... 55
  Using the Event Manager ............................................. 55
  Using the Event Editor .............................................. 56
  Triggering Local Events ............................................ 56
ADDITIONAL RESOURCES .......................................... 57

## CHAPTER 7: REPORTS

UNDERSTANDING REPORTS .......................................... 58
  Shipwide PMS Performance Report .............................. 58
  EGL Report ........................................................... 59
  PMS Performance Report .......................................... 59
  13 Week Report ...................................................... 60
  MRC Accomplishment Report .................................... 60
  To-Do-List Report .................................................. 60
  PMS Check Viewer .................................................. 61
  Forecasting Report .................................................. 62
  Flip Page Report .................................................... 62
ADDITIONAL RESOURCES .......................................... 63

## CHAPTER 8: PMS BROWSER

UNDERSTANDING THE PMS BROWSER .......................... 64
ADDITIONAL RESOURCES .......................................... 66

## CHAPTER 9: LIST VIEW

UNDERSTANDING THE LIST VIEW ................................. 67
  Using the Split Check Feature .................................. 68
ADDITIONAL RESOURCES .......................................... 68
CHAPTER 1: START THE CYCLE

SKED runs in cycles. For the sake of simplicity, SKED’s cycle begins with the proper installation of the application. Once installation is complete, several tasks must be performed by the 3M Coordinator to prepare SKED 3.1 for use. Once SKED is ready for use, the Workcenter Supervisor has several responsibilities.

TOPICS

- Installing SKED 3.1
- Preparing SKED 3.1 for Use
- Verifying PMS Data Version
- Understanding SKED modes
- Creating & Modifying User Accounts
- Creating a New Workcenter
- Using the Data Entry Editor
- Introducing Feedback Reports
- Finalizing Cycle
INSTALLING SKED 3.1

SKED 3.1 is installed by the 3M Coordinator or ADP Personnel. Designed to replace all previous versions of SKED, version 3.1 can run in three different modes:

1. **Server Mode:** Requires a server connection and Microsoft SQL Server 7 or 2000. All SKED data is stored in a central location on the SQL Server. This is the preferred mode of installation because all of the features in SKED 3.1 are available. This mode requires an on-site installation.

2. **Network Mode:** This mode installs SKED 3.1 on a network-shared drive. All of the SKED data will be stored on the network server. In this mode, you cannot access OMMS-NG for stock checks.

3. **Desktop Mode:** Allows SKED 3.1 to run on a stand-alone computer in one of two ways:
   a. **Desktop Mode with Computer Shared Resources:** Multiple users can use the same computer and save their data to a shared directory on the stand-alone computer.
   b. **Desktop Mode with User-Only Resources:** Every person who uses the stand-alone computer will have their own SKED data in an isolated directory.

   **NOTE:** *This is the least recommending type of installation!*

   This configuration does not require SQL Server. However, the following functions are unavailable:
   - Interface with OMMS-NG or MicroSnap
   - Associate equipment
   - Receive work candidate information
   - Perform stock checks
   - Open a work candidate for repair parts
   - Pass completed work candidate information when marking off a maintenance action

PREPARING SKED 3.1 FOR USE

After SKED is installed, the 3MC must perform the following tasks:

**Build the Chain of Command:** This is the hierarchy through which tasks are performed and permissions granted. The 3MC creates all the departments and divisions and assigns Department Heads and Division Officers.

**Set User Levels and Permissions:** These determine what you are allowed to do in SKED. For instance, Workcenter Supervisor permissions let you create, edit, maintain, view and print schedules. It is intended that all workcenter supervisors will make routine changes and updates to schedules.

**Create User Account:** 3MC will create his account and selected user accounts such as Department Heads and Division Officers. **NOTE:** The Workcenter Supervisor will also create user accounts. See the Creating & Modifying User Accounts section.
**Update PMS Data:** Updating the PMS Data provides the following benefits:

- You will have the most up-to-date MIP/MRC Cards and SPMIG data
- Force Revision information will be available for your entire activity to perform FRs without the PMS CD
- Enables you to use the internal PMS Browser

**Warning:** The SKED database should only be updated with the most recent Navy PMS CD. If older CDs are loaded, workcenters will receive bogus Force Revision notifications and not be able to view the most recent versions of the PMS documents from SKED.

**UNDERSTANDING SKED MODES**

SKED can run in several different modes. Modes affect which functions of SKED are available to the user. To determine which mode SKED is running, look in the lower right hand corner of the screen. The name of the mode will be displayed. The most important SKED modes are:

**Data Entry mode:** After SKED is installed, or a revision is performed, SKED automatically runs in Data Entry mode. This is where the cycle is built by accepting and rejecting documents that apply to the workcenter. After the cycle is built, it must be approved and finalized by the Department Head.

**Revise mode:** Once the cycle is finalized, the boards are in Revise mode. In this mode, each piece of equipment associated with the workcenter is on the schedule and all the maintenance related to those equipment items is listed as well. The Workcenter Supervisor has to rearrange the checks on the board, add crew members to the workcenter list and assign maintenance for all the PMS checks. This is the only mode where checks can be moved without marking up the board. Once the Workcenter Supervisor has the checks arranged and all the maintenance planned, each quarter board has to be approved and finalized by the Department Head.

**Maintenance mode:** Once a quarter is finalized, that quarter board is in Maintenance mode. In this mode, crew members are performing maintenance and the Workcenter Supervisor is marking off the checks on the board, performing spot checks, etc...

**VERIFYING PMS DATA VERSION**

Having the most up-to-date PMS documents is imperative for the proper function of SKED. Using the wrong PMS data is like trying to operate a DVD player with instructions for a microwave oven. Workcenter Center Supervisors must verify which version of the PMS Data SKED is accessing.

**To verify the PMS data version:**

1. Log in to SKED.
2. On the File menu, click Open. The Open Workcenter dialog box appears.
3. On the bottom left of the screen, the Current PMS Data Information appears.
CREATING & MODIFYING USER ACCOUNTS

Workcenter Supervisors are responsible for creating and maintaining the user accounts of everyone in their workcenter. You must know how to perform the following actions:

To create user accounts:
1. On the Admin menu, point to Users and click Add User. The New User dialog box displays.
2. Enter the user’s last name in the Last Name edit box.
3. Enter the user’s first name in the First Name edit box.
4. Enter the user’s rate in the Rate dialog box.
5. From the User Category drop down, select the appropriate user category.
6. Click OK. The Edit user dialog box displays with the Name, Rate, User Category and Signature already supplied.
7. Enter the user’s email address in the Email Address edit box.
8. Click the Status tab.
9. Enter a password for the User in the Password edit box.
   NOTE: Keep this generic, such as PASSWORD. The user can log on and then change the password for security reasons.
10. If you wish to give the user special permissions, click Modify Permissions. The Modify Permissions dialog box displays. Click the appropriate tabs and select the additional permissions you wish to grant to the user. See the Modify User Permissions section to learn more.
11. In the User Status, click Active User Account if you wish for this user to log in and perform SKED functions normally. Click Inactive User Account if you only wish to maintain the user record for record keeping only.
12. Click OK. Repeat steps 1-12 as many times as necessary.

To edit user accounts
1. On the Admin menu, point to Users and click Edit User. The Select User dialog box displays.
2. Click the user in the list whose information you wish to modify.
   NOTE: If you want to edit your own information, click Change Your Information to automatically see your information. This will make it so you don’t have to go through the trouble of finding your name in the long list.
3. Click OK. The Edit User dialog box appears.
4. In the edit boxes visible on the Information tab, modify any information you’d like. Simply click and type, or use the User Category drop down menu to modify the User Category.
5. Click the Status tab. From here you can do the following:

- **Change the password:** Simply type the new password in the Password edit box.

- **Change the User Status:** Select Active User Account if you wish to activate the user’s account. This will mean that the user may log in and perform SKED functions normally. Select Inactive User Account if you wish to maintain the user record, but no longer enable them to access SKED.

- **Modify Permissions:** Clicking this button opens the Modify Permissions dialog box. This is where you decide which functions of SKED are available to the specific user.

- **Reset Default Permissions:** This resets all the permissions back to the default settings for the user’s category level, as determined by the 3M Coordinator.

**DELETING USERS**

Important things to know before deleting users:

- You must change a user’s status account to inactive before they can be deleted. To do this, see Step 5, of the “To edit user” section above.

- In order for a user account to be properly removed from the SKED database, all references to that account need to be cleared from the appropriate documents. Once you have made the user account inactive, the account should be removed from maintenance responsibilities on the workcenter schedules and from the chain of command. It is recommended that you keep the inactive account in the system for up to a year to ensure that the user is not on any of the active boards. Inactive accounts will not appear on the user selection forms. Once a user account is deleted, any remaining links to the user account will be replaced with the text “deleted user.” This text will not affect the behavior of SKED.

**To delete user:**

1. On the Admin menu, point to Users and click Delete User. The Delete Inactive Users dialog box appears.

2. Select the user in the list you wish to delete.

3. Click Delete User. A Confirmation Delete dialog box appears.

4. Click Yes. A dialog box appears informing you the user was deleted successfully.

5. Click Ok.

**CREATING A NEW WORKCENTER**

**NOTE:** If a ship is converting workcenters from SKED 2.1, skip this section and see the Convert 2.1 Workcenters chapter.

Creating a new workcenter is simple with the New Workcenter Wizard. Workcenters can quickly be created from a NAVY PMS CD, a Centralized Data source or created manually. However, the recommended way to create a new workcenter is from a centralized data source.
New workcenters are created for the following reasons:

- A workcenter has been added to your ship
- A workcenter was deleted
- New construction
- You’re converting a paper system into SKED

When first building a workcenter or converting from an older version of SKED, properly bind mandatory related checks on the quarter boards, and for weekly or daily checks, the weekly boards. This reduces the chance of having stray checks on the boards and allows them to display properly on the quarter and weekly boards. Additionally, when a mandatory related R check is associated with a daily or weekly check, the R check will automatically appear on the quarterly board all by itself. This is normal. By looking at the Check Properties feature, the user will see that the R check is related to a check not normally displayed on the quarter board.

To create a new workcenter from a centralized data source:

1. Click File and click New. The New Workcenter Wizard appears.
2. Click Continue.
3. Click Create New Workcenter from Centralized Data Source.
4. Click Next. The Select Hull and Workcenter dialog box appears.
5. From the Hull drop down menu, click your Hull Number.
6. From the Workcenter drop down menu, click your workcenter.
   
   **NOTE:** If your hull number or workcenter is not listed, select a similar hull or workcenter and you may customize it to suit your needs.

7. Click Next. The Select MIPs to Include dialog box appears.
8. Select the MIPs you wish to add to your workcenter. To select individual MIPs, click the MIP and then click the > button. To select all MIPs, click the >> button.
9. Click Next. A message appears saying “Gathering Component Information...please wait.”
10. The Assign Component Rows dialog box appears. Click each MIP and select any of the predefined component names that will be part of your workcenter. If the icon turns green, it will automatically be added to your schedule. Any component row with a black icon will not be added to your schedule.
11. Click Next. The Select Details dialog box appears.
12. Enter your workcenter name if it is not already supplied.
13. Enter the Starting Quarter.
14. Enter the Quarter Start date.
   
   **NOTE:** Each quarter always starts on the 1st Monday of January, April, July and October. Typically quarters are 13 weeks for surface ships and 15 weeks for subfleet. Occasionally there may be 14 week quarters, and consequently a 12 week quarter. Never assume that a 14 week is always followed by a 12 week quarter.
15. Select the Period type.
16. Click Next. The Select Owner Information dialog box appears.
17. Select your Division in the Division drop down menu.
18. Click your Workcenter Supervisor in the list box.
20. Review the information you have entered and verify that it is correct.
21. Click Finish if you are satisfied. The Data Entry Editor will open. If you are unsatisfied, Click Previous to make any changes.

**USING THE DATA ENTRY EDITOR**

Once the New Workcenter Wizard is completed, SKED is automatically in Data Entry Mode. Data Entry Mode is the first of three modes in which SKED can run. While in Data Entry mode, the user has access to the Data Entry Editor which helps build the cycle by enabling the user to accept and reject PMS documents that apply to his workcenter. It also provides a hierarchical break down of the workcenter. All of the MIPs, Component Rows, and MRCs contained in the workcenter are listed in the editor.

MIPs that were added to the schedule during the creation of the workcenter appear with blue icons. MIPs that were excluded during the creation of the workcenter appear with gray icons.

The Data Entry Editor also enables the user to modify two types of maintenance:

- **Mandatory related maintenance**: Mandatory related maintenance is when two maintenance items must be performed together, as denoted by a # in the Related Maintenance column on the MIP. Sometimes the mandatory related maintenance MRC comes from another MIP as well.

- **Convenience related maintenance**: Convenience related maintenance is essentially another maintenance task that would be “convenient” to take care of while you’re performing another task. This is denoted by an MRC being listed in the Related Maintenance column on the MIP. It would be best to associate these two items. Sometimes the convenience related maintenance MRC comes from another MIP as well.

Workcenter Supervisors must know how to perform the following actions:

**To add a component:**

1. On the Schedules menu, click Data Entry.
2. Click the MIP you’d like to add a component to.
3. Click Add Component.
4. On the right, enter the Component Name in the Component Name edit box.

   **NOTE:** If you add a new component, you need to add the appropriate MRCs to that component.

**To delete component:**

1. On the Schedules menu, click Data Entry
2. Click the Component you’d like to delete.
3. Click Delete Component. The Component will turn black.
To copy a component:

It’s best to copy components once you have modified the component row to contain only the MRCs that you want on that row. This will save you time when creating EGLs. You will not have to add and delete MRCs and any related maintenance will carry over to the copied components. You can simply rename the component row for the EGL and be done.

1. On the Schedules menu, click Data Entry.

   **NOTE:** If you do not see Data Entry on the Schedule menu, you are not in Data Entry mode. Click Restart Cycle on the Schedules menu to access the Data Entry Editor.

2. Click the component you’d like to copy.

3. Click Copy Component.

To rename a component:

1. On the Schedules menu, click Data Entry.

2. Click the Component you’d like to rename.

3. On the right, type the new name in the Component Name edit box.

To add a MIP:

1. On the Schedules menu, click Data Entry.

2. Select your workcenter at the top of the tree.

3. Click Add MIP.

4. On the left, enter the MIP number.

5. Enter the MIP Date Code.

   **NOTE:** Do not put spaces in the MIP Number or Date Code.

To delete a MIP:

1. On the Schedules menu, click Data Entry.

2. Click the MIP you’d like to delete.

3. Click Delete MIP. The MIP will turn black.

   **NOTE:** If you wish to undelete the MIP, click Undelete. The folder will turn blue.

To add a deleted MIP back to the workcenter:

   **NOTE:** MIPs you chose not to include in your workcenter are gray. To add them back into the workcenter, do the following:

1. On the Schedules menu, click Data Entry.

2. Click the gray MIP you wish to add back to the workcenter.

3. Click Undelete MIP. The MIP turns blue.
To add an MRC:
1. On the Schedules menu, click Data Entry.
2. Click the Component you’d like to add an MRC to.
3. Click Add MRC.

To delete an MRC:
1. On the Schedules menu, click Data Entry.
2. Click the Component from which you’d like to delete an MRC.
3. Select the MRC you wish to delete and click Delete MRC.

To modify mandatory related maintenance:
1. On the Schedules menu, click Data Entry.
2. Click the MRC whose mandatory related maintenance you’d like to modify.
3. Click Modify beneath the Mandatory Related Maintenance edit box. The Mandatory Related Maintenance dialog appears.
4. In the list box on the right, select the MRC that the MIP indicates should be associated.
5. Click OK.
6. Ensure that only the MRCs you wish to associate are highlighted, and click OK. All of the associated MRCs appear in the Mandatory Related Maintenance edit box.

To modify cross MIP mandatory related maintenance:
1. On the Schedules menu, click Data Entry.
2. Click the MRC whose mandatory related maintenance MRC comes from another MIP.
3. Click Add Cross-MIP Related Maint. The Add Cross-MIP Related Maintenance dialog box appears.
4. In the list box on the left, click the MIP that contains the MRC you wish to associate. All the MRCs assigned to that MIP appear on the right.
5. In the right list box, click the MRC you wish to associate.
6. Click Add MRC Reference. The Mandatory Related Maintenance dialog reappears, and the MRC you added appears in the list box.
7. Ensure that only the MRCs you wish to associate are highlighted, and click OK. All of the MRCs you’ve associated appear in the Mandatory Related Maintenance edit box.

To modify convenience related maintenance:
1. On the Schedules menu, click Data Entry.
2. Click the MRC whose convenience related maintenance you’d like to modify.
3. Click Modify beneath the Convenience Related Maintenance edit box. The Convenience Related Maintenance dialog appears.
4. In the list box on the right, select the MRC that the MIP says should be associated.
5. Click OK.
6. Ensure that only the MRCs you wish to associate are highlighted, and click OK. All of the MRCs you’ve associated appear in the Convenience Related Maintenance edit box.
To modify cross MIP convenience related maintenance:

1. On the Schedules menu, click Data Entry.
2. Click the MRC whose convenience related maintenance MRC is on another MIP.
3. Click Add Cross-MIP Related Maint. The Add Cross-MIP Related Maintenance dialog box appears.
4. In the list box on the left, click the MIP that contains the MRC you wish to associate. All the MRCs assigned to that MIP appear on the right.
5. In the right list box, click the MRC you wish to associate.
6. Click Add MRC Reference. The Convenience Related Maintenance dialog box reappears, and the MRC you added appears in the list box.
7. Ensure that only the MRCs you wish to associate are highlighted and click OK. All of the MRCs you’ve associated appear in the Convenience Related Maintenance edit box.

To modify start period:

**NOTE:** *Period is synonymous with “quarter” in this instance.*

1. On the Schedules menu, click Data Entry.
2. Click the MRC whose start period you wish to modify.
3. In the Start Period edit box, type the quarter number you wish for that check to start.

**INTRODUCING FEEDBACK REPORTS**

Feedback Reports are a valuable communication tool between the ships and the FTSCs. They help inform the FTSCs of what the ship needs and provide a means for the FTSCs to respond to those needs.

At this point in the life cycle, a Feedback Report may need to be created for the following reasons:

- New equipment has been added to the workcenter and requires a new MIP or MRC.
- A piece of equipment has been removed from the workcenter and PMS coverage is no longer necessary.

Feedback Reports will be covered in more depth in the Feedback Reports chapter.

**FINALIZING CYCLE**

After all the component rows have been created, MIPs and MRCs have been added for the workcenter, and related checks have been modified, the cycle can be finalized. It is the responsibility of the Department Head to finalize cycles. Workcenter Supervisors need to tell their Department Head that their cycle is ready to be finalized.

Once a cycle is finalized, it is hammered in stone and cannot be changed without the Department Head knowing about it. Essentially, there is no covering up mistakes.

After finalizing the board, it will be in Revise mode. See the Revise Quarter chapter to learn more. When the cycle is finalized, SKED 3.1 prompts the user to backup the workcenter. Backups are an integral part to SKED and invaluable in case of data loss. From backups users can restore the workcenter back to a previous state. Backups will be discussed more thoroughly in the Restore chapter.
### KEY TERMS

<table>
<thead>
<tr>
<th>Term</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chain of Command</td>
<td>The hierarchy through which tasks are performed.</td>
</tr>
<tr>
<td>Convenience Related Maintenance</td>
<td>Another maintenance task that would be “convenient” to take care of while performing another task.</td>
</tr>
<tr>
<td>Mandatory Related Maintenance</td>
<td>Mandatory related maintenance is when two maintenance items must be performed together, as denoted by a # in the Related Maintenance column on the MIP. Sometimes the mandatory related maintenance MRC comes from another MIP as well.</td>
</tr>
<tr>
<td>MIPs</td>
<td>Maintenance Index Page. A table of contents of all MRCs for a MIP group.</td>
</tr>
<tr>
<td>MRCs</td>
<td>Maintenance Required Cards that provide procedural steps for the maintenance that is to be performed on a piece of equipment.</td>
</tr>
</tbody>
</table>

### ADDITIONAL RESOURCES

- **SKED 3.1 Quick Start Guide,**
  Network Mode, Set Up SKED 3.1
- **SKED 3.1 Online Help,**
  Admin Features, Data Entry Mode, New Workcenter Wizard, Convert Workcenters
- **Ship’s 3M Manual,**
  OPNAVINST 4790C
Once the cycle has been finalized, the board is put into Revise mode. Boards in SKED can run in three different modes: Data Entry mode, which was covered in the Start My Cycle section; Revise mode and Maintenance mode. Maintenance mode will be discussed in the next chapter. To determine which mode the board is in, look in the lower right hand corner. The status bar will indicate which mode the board is operating. Different modes enable users to perform different functions.
UNDERSTANDING REVISE MODE

There is some confusion between Revise mode and revisions. They are two separate entities:

Revise Mode: When in Revise mode, the following holds true:

▪ Each piece of equipment associated with your workcenter is on the schedule and all the maintenance related to those items is listed as well.
▪ The quarter board is not finalized.
▪ The cycle board is finalized.
▪ You can rearrange checks on the quarter board without making marks on the board.

When moving checks from week to week in Revise mode, verify that all checks are within periodicity. Underneath the Tools menu, you can run Verify Schedules and it tells you if a check has been brought out of periodicity.

Keep an eye out on your monthly checks. Due to the monthly periodicity interval and the inconsistent number of days in each month, it is possible for SKED to “creep” monthly checks out on your schedule. While this is still considered in periodicity, you could end up with two checks scheduled in a quarter instead of three.

Revisions: These are completely different from Revise mode. There are five types of revisions which will be discussed in the Generate New Quarter chapter:

▪ Force Revision: Performed twice a year from the NAVY PMS CDs.
▪ Admin Revision: Performed if you have new equipment and need to add it to the boards.
▪ ACN Revision: An advanced change notice that comes out between Force Revisions.
▪ DIT Revision (Documentation/Information Transmittal): Used to forward new issue and superceded PMS documentation between FRs. Provides PMS reference or status information and narrative replies to non-technical FBRs.
▪ FBR Revision: A reply back from a feedback report.

ADDING CREW MEMBERS TO THE WORKCENTER LIST

The Workcenter Supervisor must add crew members to the workcenter list so that maintenance responsibilities can easily be assigned.

To add crew members to workcenter list:

2. Click Add Crew Member. The Select User dialog box appears.
3. Select a name from the list.
4. Click OK. The name appears on the Crew List. Repeat as many times as necessary.
ASSIGNING MAINTENANCE RESPONSIBILITIES

Once all the crew members have been added, maintenance responsibilities can be assigned to each of them. Each check on the board requires a crew member to perform the maintenance. If no maintenance responsibilities are assigned, no maintenance can be accomplished.

To assign maintenance responsibilities:
2. Select the Component from the Components list box you wish to assign a crew member. In the Crew List, a list of people will appear.
3. Select a person from the Crew List list box. Their name will be highlighted. This indicates that maintenance for the component selected is now assigned to the person whose name is highlighted.
4. Repeat steps 2-3 as many times as necessary.

MODIFYING CHECKS

Rearranging checks is necessary because during the Data Entry mode, checks are added to the board without any thought as to the best time to perform the maintenance. It is the Workcenter Supervisor’s job to manage the performance of maintenance and that means rearranging the checks so that 20 checks don’t appear on the same day, that crew members are available, etc... Essentially, the Workcenter Supervisor needs to work out the logistics, take into consideration all the maintenance that has to be performed and find the most efficient way to arrange the checks and still stay within periodicity.

The only time that checks can be moved around without marking up the board is in Revise mode. It is important that the Workcenter Supervisor be confident with how the checks are arranged on the board, because to change something once the quarter is finalized will require a trip to the Department Head to ask that the board be put back into Revise mode.

Adding checks may be required at this time as well. There are certain checks that need to happen prior to underway, or at other specified times. These checks need to be added into the schedule. R-checks are other checks that may need to be added to schedule. R-checks will be discussed more thoroughly in the R-checks chapter.

To rearrange checks:
1. On the Quarterly board, click the check you wish to move.
2. Drag the check to where you would like it to appear on the board.

To add checks:
1. In Revise Mode, click Quarter, Weekly, or List View on the toolbar.
2. Right-click in the box where you’d like to add a check.
3. Click Add Check. The Add Check dialog box appears.
4. Select the check you’d like to add and click OK.
REORDERING ROWS

The Workcenter Supervisor can reorder the rows on the schedule. This is purely a personal preference, but MIPs and components can be moved up and down, and the rows can be sorted by MIPs or components.

To move a MIP up:
1. Right-click anywhere on the board and click Reorder Rows. The Reorder Rows dialog box appears.
2. Select a MIP in the list box on the left.
3. Click Up, until the MIP moves to the desired location.

To move a MIP down:
1. Right-click anywhere on the board and click Reorder Rows. The Reorder Rows dialog box appears.
2. Select a MIP in the list box on the left.
3. Click Down, until the MIP moves to the desired location.

To move a component up:
1. Right-click anywhere on the board and click Reorder Rows. The Reorder Rows dialog box appears.
2. Select a MIP in the list box on the left. The associated components appear in the right list box.
3. On the right, select the component you wish to move up.
4. Click Up on the right side, until the component moves to the desired location.

To move a component down:
1. Right-click anywhere on the board and click Reorder Rows. The Reorder Rows dialog box appears.
2. Select a MIP in the list box on the left. The associated components appear in the right list box.
3. On the right, select the component you wish to move down.
4. Click Down on the right side, until the component moves to the desired location.

To sort MIPs:
1. Right-click anywhere on the board and click Reorder Rows. The Reorder Rows dialog box appears.
2. Under the list box on the left, click Sort MIPs. The MIPs will be placed in alphanumeric order.

To sort components:
1. Right-click anywhere on the board and click Reorder Rows. The Reorder Rows dialog box appears.
2. Under the list box on the right, click Sort Components. The components will be placed in alphabetical order.
ASSOCIATE EQUIPMENT

Proper management and maintenance require the correct equipment selected for your workcenter, the correct MRCs assigned to appropriate component rows, and the correct equipment associated to the MRCs. When workcenters are created, MIPs are selected based on the equipment that the workcenter is responsible for. For example, a workcenter could contain an eyewash station, an AN/SPS-67 radar, a hydraulic valve and a manual valve. Component rows are then built for the MRCs based on a logical grouping of equipment. The eyewash station and the AN/SPS-67 radar would each get their own rows because they could not be put into logical groupings. The two valves would require two rows, hydraulic valves and manual valves, because they are similar, yet require different MRCs. A component row should contain equipment that requires similar maintenance. Next, MRCs are selected for each row. By default all the MRCs contained in the MIP show up on the row, but SKED lets the user select just the MRCs that correspond to the row. Equipment records are then selected for each row. This is where the specific RIN is chosen for the piece of equipment.

SKED 3.1 handles equipment associations differently than previous versions of SKED. Version 3.1 divides equipment associations into two steps:

1. **Selecting equipment:** The Equipment Selection Wizard assists you in assigning equipment line items to the PMS component rows.

2. **Associating MRCs to the equipment:** The Associate MRCs Wizard guides you through the process of associating MRCs to equipment records.

**NOTE:** These wizards focus on one component row at a time to help alleviate any confusion. Both wizards will need to be run for every component row on the schedule.

The wizards are useful tools and provide the following benefits:

1. **Assistance with building proper Equipment Guide Lists (EGLs):** When multiple pieces of equipment are assigned to a single PMS component row, the information from the equipment line items can be used to generate EGL forms. In addition to using the equipment records received from OMMS-NG, this wizard allows the user to enter unlisted equipment items to ensure that the user can still generate EGLs even if the ship’s equipment file is inaccurate.

2. **Reporting of PMS Accomplishments:** By adding equipment records to a PMS schedule and associating those records with MRC cards, work candidates will automatically be generated for completed PMS items and not require any action by the user. They are transmitted to OMMS-NG and closed automatically to be transmitted off ship. These records can be used by analysts to help better organize PMS procedures and to better meet the needs of the ship; possibly reducing the amount of PMS items that need to be accomplished.
Opening Work Candidates for Ordering Parts: In addition to completed PMS actions receiving work candidates, associating MRCs to equipment records allows SKED to open deferred work candidates for ordering parts. This applies to MRC cards with a “Y” in the repair parts indicator only and must be requested by the workcenter supervisor through a given week.

Once Equipment has been selected and associated, you can also Modify Equipment Associations as needed.

Using the Equipment Selection Wizard

The Equipment Selection Wizard provides four different ways to filter equipment records: by workcenter, by nomenclature, by HCS, and by location information. The instructions below contain steps for using all three filters, but it is not necessary to use all three. Only one filter must be used to return any records from the equipment file.

To open the Equipment Selection Wizard:
1. On the Schedule menu, point to Modify Equipment Associations.
2. Click Add/Remove Equipment. The Select Schedule Row dialog box appears.

To select component row:
1. Click the row you wish to assign equipment records to.
2. Click Next. The Set Equipment Filters dialog box appears.

To filter equipment by workcenter:
1. Click the workcenter(s) whose equipment records you wish to filter.
   
   **NOTE:** You can select multiple workcenters.
2. Click Next.

To filter equipment by nomenclature:
1. Type the nomenclature in the nomenclature edit box. For example “Pump.”
2. Click Next. The Select Equipment Records dialog box appears.

To filter equipment by HSC:
1. Type the HSC in the HSC edit box.
2. Click Next. The Select Equipment Records dialog box appears.
To filter equipment by location information:

1. From the deck drop down menu, click the deck you wish to filter by.
2. In the Frame edit box, type the Frame.
3. From the Center Line drop down, click the Center Line you wish to filter by.
4. From the Compartment drop down, click the Compartment you wish to filter by.
5. Click Next. The Select Equipment Records dialog box appears.

To add equipment to the row:

1. In the equipment search results section of the Select Equipment Records dialog box, select the equipment you wish to add to the row.
2. Click Add Equipment. The equipment appears in the list below.
3. Click Next to continue with the Equipment Selection Wizard.

To remove equipment from the row:

1. In the Equipment on this Row section of the Select Equipment Records dialog box, select the equipment you wish to remove.
2. Click Remove Equipment. It disappears from the list.
3. Click Next to continue with the Equipment Selection Wizard.

To add unlisted equipment:

2. Enter the Nomenclature in the Nomenclature edit box.
3. Enter the Serial Number in the Serial Num edit box.
4. Enter the Location in the Location dialog box.
5. Click OK. The Review Selection dialog box appears.

To review selections:

1. Review the selections. Click Finish if everything is correct. This automatically takes you to the Modify Equipment Associations dialog box. See the Modify Equipment Associations section for more.

   **NOTE:** If this step is not completed, all of the associations will not be made.

2. If changes need to be made, click Previous. Click Finish when you are satisfied that the information listed is correct.
Using the Associate MRCs Wizard

The Associate MRCs Wizard provides two different ways to associate MRCs. At Step 2 of the wizard, a choice must be made between these two options:

**Associate by MRC:** This means that you will first choose an MRC and then select the equipment records that go with the selected MRC card.

**Associate by Equipment:** This means that you will first choose an equipment record and then select which MRCs go with that piece of equipment.

It is simply personal preference that dictates the choice.

**To open the Associate MRCs Wizard:**

1. On the Schedules menu, click Modify Equipment Associations. The Modify Equipment Associations dialog box appears.
2. Click Associate MRCs. The Associate MRCs Wizard Appears.
3. Click Previous. This takes you to the Select Schedule Row dialog box, which is the first step of the Wizard.

**To make associations by MRC:**

1. Follow the “To open the Associate MRCs Wizard” instructions above.
2. Click the row you wish to assign equipment records to.
3. Click Next.
4. Click Associate by MRC.
5. Click Next.
6. In the MRC list box, click the MRC you wish to associate equipment to. The Equipment Records list box will display all the possible equipment records that could be associated to that MRC.

   **NOTE:** Highlighted items in the Equipment Records list box are already associated to the MRC.

7. Click the Equipment in the Equipment Records list box you wish to associate. It will be highlighted. You may associate as many as you’d like.
8. You can also break an association by doing the following:
   a. In the MRC list box, click the MRC whose association to an equipment record you wish to break. All of the associated Equipment Records appear highlighted in the Equipment Records list box.
   b. Click the Equipment Record that is highlighted. It will no longer be highlighted, and therefore, not associated with the MRC.
   c. Click Next.
9. Click Next. The Review MRC Associations dialog box appears.
10. Review the associations. If satisfied, click Next.

   **NOTE:** If this step is not completed, all of the associations will not be made.
11. If changes need to be made, click Previous.
To make associations by equipment:

1. Follow the “To open the Associate MRCs Wizard” instructions above.
2. Click the row you wish to assign equipment records to.
3. Click Next.
4. Click Associate by Equipment.
5. Click Next.
6. In the Equipment Records list box, click the Equipment Record you wish to associate an MRC to. The MRC list box will display all the possible MRCs that could be associated to that equipment record.

   **NOTE:** Highlighted items in the MRC list box are already associated to the equipment record.

7. Click the MRC in the MRCs list box you wish to associate. It will become highlighted. You may associate as many as you’d like.
8. Click Next to continue with the Associate MRCs Wizard, or follow these instructions to break an equipment association.
   a. In the Equipment Record list box, click the Equipment Record whose association to an MRC you wish to break. All of the associated MRCs appear highlighted in the MRCs list box.
   b. Click the MRC that is highlighted. It will no longer be highlighted, and therefore, not associated with the Equipment Record.
   c. Click Next to continue with the Associate MRCs Wizard.

   **NOTE:** If this step is not completed, all of the associations will not be made.

11. If changes need to be made, click Previous.

**Modifying Equipment Associations**

If the equipment associations need to be modified, SKED 3.1 provides a Modify Equipment Associations dialog box. The dialog box lists all the component rows on the schedule. The MIP code, Component Row name, the number of pieces of equipment associated to the row and Notes appear. Notes will only display if there is a problem with the equipment associations for that row.

Icons may also appear to indicate possible conflicts:

- **Red icons:** Indicate that no equipment is on the row. If a red icon appears, click Add/Remove Equipment. This takes the user back to Step 1 of the Equipment Selection Wizard for the selected component. Follow the steps in the wizard to add equipment to that row.

- **Yellow icons:** Indicate that either equipment is on the row and not associated to an MRC, or an MRC is on the row and is not associated to a piece of equipment. If a yellow icon appears, click Associate MRCs to properly associate the equipment. Clicking Associate MRCs takes the user back to Step 2 of the Associate MRCs Wizard.
To access the Modify Equipment Associations dialog box:

1. On the Schedules menu, click Modify Equipment Associations.
2. The Modify Equipment Associations dialog box appears.
3. If red icons appear, click Add/Remove Equipment to add equipment to the row.
4. If yellow icons appears, click Associate MRCs to properly associate the equipment.

BUILDING EGLS

EGLs are Equipment Guide Lists that show how much maintenance can be performed during a normal work day. It designates a type of equipment that needs maintenance performed such as fire extinguishers.

The EGL Wizard helps create Equipment Guide Lists from the information on your schedule. EGLs may be created based on Equipment records retrieved from OMMS-NG or by manually entering the equipment information.

NOTE: If you wish to create an EGL from the OMMS-NG equipment records, those records must be associated to the component row using the Equipment Association Wizard prior to running the EGL Wizard.

To build EGLS with the EGL Wizard:

1. On the Reports menu, point to EGL Reports and click New EGL Wizard. The New EGL Wizard appears.
2. Click Next. The Select Component Row dialog box appears.
3. Click the component row for which you would like to create an EGL.
4. Click Next. The Select MRC dialog box appears.
5. Click the MRC for which you wish to generate an EGL.
6. Click Next. The Add and Modify Equipment Information dialog appears.
7. At this point in the wizard the following actions are available:

   To modify the nomenclature:
   a. Click an item in the Nomenclature column.
   b. Type a new nomenclature.
   c. Click anywhere outside the edit box.

   NOTE: This is done on an as needed basis.

   To modify Serial #:
   a. Click the Serial # to modify it.
   b. Type the changes in the edit box.
   c. Click anywhere outside the edit box.

   NOTE: This is done on an as needed basis. Some items may not have serial numbers. If a serial number must be added, click the empty cell in the Serial # column and add the appropriate Serial #.
To modify location:
   a. Click the Location you’d like to modify.
   b. Type changes.
   c. Click anywhere outside that edit box.

NOTE: This is done on an as needed basis. Some items may not have a location listed. If a location must be added, click the empty cell in the Location column and add the appropriate location.

To add notes:
   a. Click the row on the Notes column where you’d like to add a note.
   b. Enter the note.
   c. Click anywhere outside that edit box.

To remove equipment:
   a. Click Remove Equipment. The Delete EGL Line Item dialog box appears.
   b. Click the EGL Line Item you wish to delete.
   c. Click Delete.

NOTE: Click Cancel if you do not wish to delete any of the items.

To add unlisted equipment:
   a. Click Add Unlisted Equipment. The Add Unlisted Equipment Records dialog box appears.
   b. Enter Nomenclature in the Nomenclature edit box.
   c. Enter Serial number in the Serial Num. edit box.
   d. Enter Location in the Location edit box.
   e. Click OK. The item appears in the list of equipment.

NOTE: This should only be used if the equipment in question cannot be located in the equipment list that was provided from the ship’s configuration file. If this form is used, it’s recommended that a CK form be submitted to OMMS-NG to have the item added to the master file.

8. Click Next. The View Complete EGL Details dialog box appears.
9. Verify the MIP and MRC number and periodicity.
10. Change the component row name to reflect the change in EGL status. For instance, add “EGL 1” to the component name.
11. Enter the EGL number in the EGL edit box. This number is for display purposes on the EGL Report Form and must be greater than 0.
12. If the MRC is classified, click the MRC for this EGL is classified check box.
13. If everything is correct, click Finish.
14. Click Previous if any changes need to be made.
VERIFYING THE SCHEDULE

The Schedule Verification tool quickly identifies any checks that are out of periodicity, and also clears out any of the periodicity marks. The schedule should be validated any time boards are generated or PMS checks are moved from week to week. This helps ensure no PMS checks are moved out of periodicity.

The schedule validation tool will change any check that is out of periodicity to red. The Clear Out of Periodicity Marks tool will turn the check back to black after the check has been moved within periodicity.

To verify the schedule:
1. On the Tools menu, point to Enhanced Schedule Displays>Schedule Verification and click Verify Schedule Periodicity Ranges.
2. If no errors are found, you will see a No Errors Detected dialog box. Click OK.
3. If errors are found, the dialog box will tell you how many errors. Click OK.
4. The errors will appear red on the schedule.
5. Move the checks so that they are within periodicity.

To clear out of periodicity marks:
1. On the Tools menu, point to Enhanced Schedule Displays>Schedule Verification and click Clear Out of Periodicity Marks.
2. All red marks will be removed from the checks that are no longer out of periodicity.

FINALIZING THE QUARTER

At this point in the cycle, it is time to finalize the quarter. The Workcenter Supervisor needs to notify the Department Head or higher that the board is ready to be finalized. Understand that once the board is finalized, the schedule is set in stone and cannot be modified without having to ask the Department Head to put SKED back into Revise mode.

While the Department Head is finalizing the quarter, SKED will prompt the Department Head to backup the SKED database. Backups will be discussed in the Restore chapter, but understand that they are extremely important. They can help restore workcenters in case of hardware failure or data loss.

Once the quarter is finalized, the board goes into Maintenance Mode.
<table>
<thead>
<tr>
<th><strong>KEY TERMS</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Component Row:</strong> A grouping or collection of actual pieces of equipment that have similar maintenance requirements.</td>
</tr>
<tr>
<td><strong>EGL:</strong> Equipment Guide List. This shows how much maintenance can be performed during a normal work day. It designates similar equipment that needs maintenance performed, i.e., fire extinguishers.</td>
</tr>
</tbody>
</table>

**ADDITIONAL RESOURCES**

**SKED 3.1 Online Help,**  
Revise Mode, Equipment Associations, Schedule Verification

**Ship’s 3M Manual,**  
OPNAVINST 4790C
Once the quarter has been finalized, the board is put into Maintenance mode. Each piece of equipment associated with the workcenter is on the schedule and crew members have been assigned to perform maintenance. Crew members are on the ship, performing checks, spot checks and workcenter supervisors can mark up the board.
UNDERSTANDING MAINTENANCE MODE

This mode indicates that the cycle and quarter boards are finalized and have been approved by the Department Head. When the board is in this mode, maintenance is in progress.

When in Maintenance mode, the following holds true:

▪ Each piece of equipment associated with your workcenter is on the schedule and all the maintenance related to those equipment items is listed as well.

▪ The quarter board is finalized.

▪ The cycle board is finalized.

▪ Checks cannot be rearranged on the quarter board without making marks on the board.

SKED maintains three “active” quarters of scheduling data for each workcenter. The state of these quarters is left up to the Workcenter Supervisor to maintain. It is recommended that at least one of the active quarters be in revise mode, which means it is a future quarter. This topic will be discussed more thoroughly in the Generate New Quarters chapter.

TIP

SKED maintains three “active” quarters of scheduling data for each workcenter. The state of these quarters is left up to the Workcenter Supervisor to maintain. It is recommended that at least one of the active quarters be in revise mode, which means it is a future quarter. This topic will be discussed more thoroughly in the Generate New Quarters chapter.

UNDERSTANDING WORKCENTER OPTIONS

NOTE: It is not recommended to modify the workcenter options because doing so could make the boards not comply with OPNAVINST 4790.

SKED provides a Workcenter Options dialog box. Any changes made will only affect the user’s workcenter. It is divided into 3 tabs:

General: Enables the user to rename the workcenter, determines how checks appear on all types of schedules, auto reschedules same checks in revise, binds related checks together, prints page numbers at bottom of the pages, and prompts user for backups. It can also reset defaults as determined by OPNAVINST 4790, show period type and let the user select the preferred date format to be used on the schedules.

Display: Enables the user to adjust row height, font size and colors.

Colors: Enables the user to change the color of board markings.

To view workcenter options:

1. On the File menu, click Workcenter Options.
MARKING THE BOARDS

Not all boards in SKED 3.1 can be marked, but it is important to understand the five different types of boards:

**Weekly**: Displays the particular week that the user is working, what PMS is scheduled for that week and which day it is to be accomplished. It displays who is to accomplish the PMS, and also displays Inactive Equipment Maintenance (IEM). Weekly boards move checks week to week.

**Quarter**: Shows PMS that is scheduled for the selected quarter. Different quarters have different PMS. Quarter boards also display underway times which differ from ship to ship. Quarter boards display IEM information and move checks week to week. This board can be marked.

**Cycle**: Shows an overview of all the PMS that needs to be done for a particular workcenter.

**List View**: This is the newest type of schedule. Each row corresponds to a check on the board, sorted by date, and the week that the user is currently working in is highlighted. Markings, spot checks, partial checks, split checks and missing parts are indicated by icons. This view displays man hours as well and shows which crew member is responsible for the maintenance. This board can be marked. For more information, see the List View section.

**Archived Quarter**: This mode enables the user to view a quarter board that had previously been archived. It can only be viewed and is useful to verify what maintenance was performed during previous quarters.

All five of these boards must match line for line, even though they cover different increments of time. Keep in mind that only the quarter and list view board can be marked. The diagram below shows all the board markings and their meanings:

<table>
<thead>
<tr>
<th>ICON</th>
<th>NAME</th>
<th>MEANING</th>
</tr>
</thead>
<tbody>
<tr>
<td>✗</td>
<td>Complete mark</td>
<td>PMS is accomplished</td>
</tr>
<tr>
<td></td>
<td>Defer mark</td>
<td>PMS check is deferred or non-accomplished (Requires Flip Page entry)</td>
</tr>
<tr>
<td></td>
<td>System mark</td>
<td>Satisfied by a higher authority or another PMS check of a higher priority accomplished that check or was included in a higher system check. (Requires Flip Page entry)</td>
</tr>
<tr>
<td></td>
<td>Delete mark</td>
<td>Black dash signifies that check has been deleted. (Requires Flip Page entry)</td>
</tr>
<tr>
<td></td>
<td>IEM mark</td>
<td>Blue dash signifies that equipment is in IEM</td>
</tr>
<tr>
<td></td>
<td>End/Begin IEM</td>
<td>Red vertical lines signify the beginning and end of IEM</td>
</tr>
<tr>
<td></td>
<td>Reschedule mark</td>
<td>Signifies that a check has been rescheduled.</td>
</tr>
<tr>
<td></td>
<td>EGL mark</td>
<td>Designates an EGL on a row, only seen on weekly boards.</td>
</tr>
</tbody>
</table>
To mark a check as accomplished:
1. On the toolbar, click Complete Mark tool.
2. Click the check you want to mark as accomplished. A red x appears over the check.

To mark a check as deferred or non-accomplished:
1. On the toolbar, click Defer Mark tool.
2. Click the check you want to defer. An Enter Reason Not Accomplished dialog box appears.
3. Type the reason the check is not accomplished.
4. Click OK.
5. A blue circle appears over the check.

To mark a check as deleted:
1. On the toolbar, click Delete Mark tool.
2. Click the check you want to mark as deleted. A black line appears through the check.

To mark that a check is satisfied by a higher authority or system check:
1. On the toolbar, click System Mark tool.
2. Click the check you want to mark as satisfied by a higher authority. An Enter Reason Not Accomplished dialog box appears.
3. Enter how this check was satisfied by a higher authority.
4. Click OK.
5. A C with a slash through it appears over the check.

To mark a check whose equipment is IEM:
1. On the toolbar, click IEM Mark tool.
2. Click the check whose equipment is in IEM. A blue line appears through the check.

VIEWING CHECK & ROW PROPERTIES
In Maintenance mode the user can view check and row properties. Check properties provide the following information:

- Status of the check
- Whether or not stock check information is available
- MIP and MRC code
- Periodicity
- Date the check appears on the schedule
- Notes
- Associated equipment
- Tools, parts and materials required to perform the check
- From the check properties dialog box, the user can view the MRC
Row properties provide the following information:

**MRC Summary:** Lists all the MRCs on the component row, periodicity, number of man hours, date the check was last accomplished, the minimum and maximum ranges, start and end date and the start quarter. Status of the checks is indicated by icons. A legend is handy to easily understand the status.

**Associate Equipment:** Lists any equipment associated to the selected row.

**Revision History:** Shows if birthdate codes or periodicities have changed.

**Icons:** Indicate the MRC status. A legend makes it easy to understand the status of each check.

**To view check properties:**
1. On either the Quarter, Weekly, or List View, right-click a check on the schedule.
2. Click View Check Properties. The Check Properties dialog box displays.

**To view MRC from Check Properties dialog box:**
1. Follow the instructions on the “To view check properties” section above.
2. Once the Check Properties dialog box displays, click View MRC.

**To view row properties:**
1. On the toolbar, click either Cycle View, Quarterly View, Weekly View, or List View.
2. Once a board is displayed, right-click the component row whose properties you wish to view.
3. Click Row Properties. The Component Row Properties dialog box appears.

**To view MIP:**
1. Follow steps 1-3 from the “To view row properties” section above.
2. Once the Component Row Properties dialog box appears, click View MIP. The MIP associated with this row appears in the MIP/MRC Viewer.
3. Click Print if you wish to print.
4. Click Close.

**To view MRC from Row Properties dialog box:**
1. Follow steps 1-3 from the “To view row properties” section above.
2. Once the Component Row Properties dialog box appears, click the MRC in the list you wish to view.
3. Click View MRC. The MRC appears in the MIP/MRC Viewer.
4. Click Print if you wish to print.
5. Click Close.
To view MRC history:
1. Follow steps 1-3 from the “To view row properties” section above.
2. Once the Component Row Properties dialog box appears, click the MRC in the list whose history you wish to view.
3. Click MRC History. The MRC History displays.
4. Click Close.

To show legend:
1. Follow steps 1-3 from the “To view row properties” section above.
2. Once the Component Row Properties dialog box appears, click Show Legend. The legend appears.

CREATING FLIP PAGE ENTRIES
Flip page entries enable the user to associate notes to a check. They are optional in all cases except when PMS has not been fully accomplished, i.e., partially or not accomplished, deleted or given a system mark. Flip pages may be added to all checks if desired.

To create flip page entries:
1. On the toolbar, click Quarter, Weekly, or List View.
2. Right-click a check, and click Create Flip Page Entry. The Enter Flip Page Entry dialog box appears.
3. Type the notes you want associated to the check.
4. Click OK.

BINDING CHECKS
When building the cycle schedule, maintenance checks can be related either because it is mandatory or because it’s convenient. If SKED is functioning properly, related checks should appear bound on the board like this: 9M-1(# W-1). 9M-1 is the “parent” check, while the W-1 is the “child.” In this scenario, the checks are properly bound.

However, if the check appears on the board like this: 9M-1 (#), W-1), the workcenter supervisor can manually bind and unbind check.

To bind mandatory checks:
1. On the toolbar, click Quarter View.
2. Right-click the child check (From the example above, you would click W-1), and click Bind Check.
3. Click As Mandatory. The cursor changes to a +.
4. Place the cursor (+) over the parent check and left click. The check should now appear on the schedule like this: 9M-1, (# W-1).
To bind convenience checks:

1. On the toolbar, click Quarter View.
2. Right-click the child check (From the example above, you would click W-1), and click Bind Check.
3. Click As Convenience. The cursor changes to a +.
4. Place the cursor (+) over the parent check and left click. The check should now appear on the schedule like this: 9M-1, (W-1).

To unbind checks:

1. On the toolbar, click Quarter View.
2. Right-click the child check (From the example above, you would click (W-1), and click Unbind Check.

**UPDATING SPOT CHECKS RESULTS**

The Workcenter Supervisor must perform spot checks on equipment as directed by the OPNAVINST 4790 and TYCOM directives. SKED enables the user to update the spot check results.

To update spot check results:

1. After a spot check has been performed, right-click the corresponding check on the quarter board that has been marked as completed (with a red X).
2. Click Update Spot Check Results. The Update Spot Check Results dialog box appears.
3. From the Was a Spot Check performed on this check? drop down menu, select Yes. Another question appears asking for the results of the spot check.
4. From the What was the results of the Spot Check? Drop down, select Satisfactory, Unsatisfactory or Partial.

   **NOTE:** Partial completion is when a significant portion of the maintenance is accomplished, but the maintenance person was unable to fully accomplish the MR. Secondly there was no violation of items that would have made the MR automatically considered not accomplished.

5. Click OK.

**GENERATING WORK CANDIDATES**

SKED 3.1 Server mode enables the user to pre-position parts for ordering if OMMS-NG can be accessed. Stand-alone MRCs that end with a “Y” require parts to perform the maintenance. SKED enables the user to select an ending week for which he wants to generate parts work candidates. This means that from the date the work candidate is generated, to the ending week, work candidates are being generated for every check that will be performed in that time frame.

**NOTE:** Generate work candidates far enough in advance to allow for the repair parts to come in.
INTRODUCING R-CHECKS

In Maintenance mode the user may encounter R-checks. R-checks are situational or “as required” maintenance. The Workcenter Supervisor must associate situational MRCs to R-check events according to the MIPs. Events are added, modified and deleted by the 3M Coordinator and the Workcenter Supervisor via the Event Editor.

For more information, see the R-Checks chapter.

PERFORMING BACKUPS

SKED 3.1 automatically prompts the user to backup the workcenter during several different phases of developing, revising and finalizing workcenter’s scheduling boards. Backups save the data up to the point prior to making a dramatic change to the workcenter. Backups can be saved to the hard drive, but it is highly recommended to save backups to an external drive.

*NOTE: Hardware failure or a sudden loss of power while the workcenter is being saved may corrupt the workcenter. It is STRONGLY advised that Workcenter Supervisors back up the workcenter at least once a week.*

To perform a workcenter backup:

1. On the File menu, click Backup Workcenter. The Backup Workcenter dialog box appears.
2. Click a Slot Number where you wish to store the backup. An Enter Backup Comment dialog box appears.
3. Enter a name for this backup. For example, “Before Restarting the Cycle.”
4. Click OK.

To perform an external backup:

1. On the File menu, click Backup Workcenter. The Backup Workcenter dialog box appears.
2. Click External Backup. The External Backup dialog box appears.
3. Enter a file name in the File Name edit box to identify this backup.
4. On the drop down menu on the bottom right, select the drive where you wish for the backup to reside. The list box on the right will display all the directories available on the drive.
5. Click the directory where you wish to create the backup.
6. Click OK.
### Key Terms

**Inactive Equipment Maintenance (IEM):** There are two types of IEMs: Status I and Status II. Status I is equipment that will remain on board and will be inactive for 30 days or longer and is not scheduled for corrective maintenance or overhauls. Status II is equipment that is inactive for 30 days and is directly subject to corrective maintenance, overhaul or removal for safe storage/replacement.

**Flip page entry:** Provides reasons why maintenance was not completed, or may just be notes about a check.

**R-checks:** Situational or “as required” checks.

### Additional Resources

**SKED 3.1 Online Help,**
- Maintenance Mode, Workcenter Options, Mark Up Quarter Board, New List View, Check Properties, Row Properties, Backup Workcenter

**Ship’s 3M Manual,**
- OPNAVINST 4790C
CHAPTER 4:
GENERATE NEW QUARTERS

As you will learn, SKED can only display three quarter boards at a time. This makes it necessary to generate new quarters and archive old quarters as time passes. With a thorough understanding of Revise mode and Maintenance mode, the user is ready to see how the cycle keeps moving along year after year.

TOPICS

- Understanding how the SKED cycle continues over time
- Generating New Quarters
- Returning Quarters to Revise
- Understanding Revisions
- Finalizing Revisions
- Finalizing Quarter
UNDERSTANDING HOW SKED CYCLES CONTINUE OVER TIME

At any given time, SKED can display three quarter boards. As time passes, year by year, new quarters will have to be generated and old quarters will be archived. This loop of generating quarters and archiving quarters will continue through the life cycle of the ship and enables SKED to maintain PMS schedules for years at a time.

The tricky part of SKED is knowing when to generate quarters, and which modes the quarter boards should be running at all times. It is recommended that the “active quarter” be the middle quarter. This way, the user can always see what was accomplished during the previous quarter, and can adjust what will be accomplished in the future. The following example will demonstrate a sequence of events that will be repeated over and over again throughout the life cycle of the ship. In this example, SKED has just been installed. The cycle will start on January 5, 2004 with quarter 1, quarter 2 and quarter 3 boards available to the user. Quarter 4 will be generated and quarter 1 will be archived.

On January 5, the cycle board is finalized, which puts all three quarters in Revise mode. Once the Workcenter Supervisor rearranges all the checks, adds crew members and assigns responsibilities, the quarter 1 board is approved and finalized by the Department Head. After quarter 1 is finalized, quarter 1 automatically goes into Maintenance mode. Quarter 2 and 3 are still in Revise mode.

For the next three months, quarter 1 will stay in Maintenance mode and is considered the “active quarter.” During that time, maintenance is being performed by the crew and the Workcenter Supervisor is marking up the boards. As April 5th approaches, which is the start date for quarter 2, the Workcenter Supervisor should look ahead to quarter 2 and start rearranging those checks and assigning maintenance. This should happen no later than mid-March. Once quarter 2 is properly arranged, it will be approved and finalized by the Department Head. After quarter 2 is finalized, it is in maintenance mode as well. At this point, quarter 1 and quarter 2 are in Maintenance mode, and quarter 3 is in Revise mode. However, maintenance will not actually start on quarter 2 until April 5th, which is the start date of quarter 2.

Once April 5th arrives, quarter 2 is the active quarter and maintenance begins. While maintenance is being performed, the Workcenter Supervisor can look ahead to quarter 3 and start rearranging checks and assigning maintenance. Things get interesting, though, when July 5th and quarter 3 is approaching. Since SKED can only display three quarters at a time, the Workcenter Supervisor needs to generate quarter 4 and archive quarter 1. Generating quarter 4 automatically prompts quarter 1 to be archived. After quarter 1 is archived, SKED displays quarter 2, quarter 3, and quarter 4. Once quarter 3 is finalized by the Department Head, then quarter 3 will be in Maintenance mode. Quarter 2 and 3 are in Maintenance mode and quarter 4 is in Revise mode.

During the SKED cycle, this loop of generating new quarters and archiving old quarters will be repeated over and over again until it is time to restart the cycle.

**NOTE:** It is recommended that the “active quarter” be the middle quarter. This way, the user can always see what was accomplished during the previous quarter, and can adjust what will be accomplished in the future.
GENERATING NEW QUARTERS

Once the first two Quarters in SKED are finalized, the Workcenter Supervisor can generate the next quarter.

To generate a new quarter:

1. On the Schedules menu, click Generate Quarter X, where X= the next quarter that needs to be generated. A Backup Recommendation dialog box appears.

2. Click Yes if you wish to perform a backup. Click No, if you do not wish to do this. To learn more about Performing a Backup, see the Maintain Quarter chapter. A dialog box confirming that you wish to generate the next quarter, and also archive the first quarter appears.

3. Click Yes. The first quarter is archived and the next quarter is generated.

RETURNING QUARTERS TO REVISE MODE

There may be times when the Workcenter Supervisor looks over a board that has been finalized, and sees that a mistake has been made. For example, 5 checks have been scheduled on a day when crew members will be attending classroom training and will be unable to perform maintenance.

In this case, the Workcenter Supervisor needs to get the Department Head to return the quarter to revise. This sends the board back to Revise mode where all the checks can be rearranged without marking the board.

PERFORMING REVISIONS

Revisions can be performed in both Revise and Maintenance Mode. Revisions update the PMS documents. There are 5 different types of revisions:

- **Force Revision**: Performed twice a year from the NAVY PMS CDs. Force Revisions will be covered in more depth in the Force Revision chapter at the back.

- **Admin Revision**: Performed if you have new equipment and need to add it to the boards.

- **ACN Revision**: An advanced change notice that comes out between Force Revisions.

- **DIT Revision (Documentation/Information Transmittal)**: Used to forward new issue and superceded PMS documentation between FRs. Provides PMS reference or status information and narrative replies to non-technical FBRs.

- **FBR Revision**: A reply back from a feedback report.

To perform any of these revisions, the Revision Wizard and Revision Editor are tools that make revisions as simple as possible.
Using the Revision Wizard

The Revision Wizard provides step by step instructions for performing revisions. It also offers three different methods to perform revisions: from a NAVY PMS CD, from a Centralized Data Source and Manually. The recommended method is from a centralized data source.

To open the revision wizard:
1. On the Tools menu, click Revision Wizard. The Revision Wizard appears.
2. Click Next. The Choose Revision Method dialog box appears.

To choose revision method:
1. Click Revision from Centralized Data Source.
   NOTE: This is the recommended way to perform a revision. However, revisions can be performed from the NAVY PMS CD or manually.
2. Click Next. The Select Hull and Workcenter dialog box appears.

To select hull and workcenter:
1. From the Hull drop down menu, click your Hull Number.
2. From the Workcenter drop down menu, click your workcenter.
   NOTE: If your hull number or workcenter is not listed, select a similar hull or workcenter and you may customize it to suit your needs.
3. Click Next. The Select MIPs dialog box appears.

To select MIPs:
1. Review the MIPs in the Workcenter list box. If a MIP is not used in your workcenter, click the MIP and then click the << button. The MIP appears in the Unused MIP list box and will not be added to your workcenter. If you need to add a MIP that is not listed, click Add Unlisted MIP. A list appears of all the MIPs on the CD in the Add Unlisted MIP dialog box. Select the ones you need to add and click Add MIP(s).
2. Click Next. The Revision Details dialog box appears.

To modify revision details:
1. In the Revision Type drop down menu, select the type of revision you are performing.
   NOTE: Force Revisions are covered in-depth in the Force Revision chapter. Select any other type of revision.
2. In the Revision Serial edit box, type the Revision Serial. For example, Equipment Removal for an Admin revision.
3. From the Revision Date drop down, select the date.
4. Click Next. The Review Revision Selections dialog box appears.
5. Review your selections. If you are satisfied, click Finish. This will open the Revision Editor.
6. If you are not satisfied, click Previous to make any changes.
Using the Revision Editor

The Revision Editor enables the user to accept and reject MIPs and MRCs; add, delete and rename components; and add and delete MRCs to your workcenter. The Revision Editor also displays all of the information that has changed for each MIP and MRC.

On the left of the Revision Editor there is a hierarchical representation of your workcenter. The first level of the hierarchy is the Workcenter Name. The second level lists all the MIPs contained in the workcenter. The third level lists all the components that fall under that MIP. The fourth level displays all the MRCs listed on the MIP.

Icons appear next to items in the outline. These icons provide valuable information that will help you make more informed decisions during the revision and are quickly defined by clicking Show Legend.

The right side of the screen provides all of the detailed information available for the MIPs, Components and MRCs. At the top, the icon is explained as well to help you understand the status of that particular item. Any changes that have been made are highlighted for easy recognition.

Color coding makes it easy to tell what state the document is in. This is a big change for SKED 3.1 and is designed to make performing revisions quick and painless. Revisions can be performed in a fraction of the time it used to take because SKED remembers every change you made during the last revision, and doesn’t make you repeat any of those actions.
To add component:

1. On the Tools menu, click Revision Editor.
   
   **NOTE:** If you do not see Revision Editor as an option, you are probably not in Revise Mode. See the Revise Mode section to learn how to change to that mode.

2. Click the MIP you’d like to add a component to.

3. Click Add Component.

4. On the right, enter the Component Name in the Component Name edit box.
   
   **NOTE:** If you add a new component, you also need to add the appropriate MRCs to that component.

To delete component:

1. Click the Component you’d like to delete.

2. Click Delete Component. The Component appears with a red icon and all the MRCs are red as well.

To rename component:

1. Click the Component you’d like to rename.

2. On the right, type the new name in the Component Name edit box.

To copy component:

1. Click the Component you’d like to copy.

2. Click Copy Component. The Component appears with a green dot, indicating that this is a new component for your workcenter.

To add MIP:

1. Select your workcenter at the top of the tree.

2. Click Add MIP.

3. On the left, enter the MIP Code.
   
   **NOTE:** Do not put spaces in the MIP Code or Date code.

To delete MIP:

1. Click the MIP you’d like to delete.

2. Click Delete MIP. The MIP appears with a red dot, indicating it has been deleted.
   
   **NOTE:** If you wish to undelete the MIP, click Undelete MIP. The folder will turn blue.

To add a deleted MIP back to the workcenter:

**NOTE:** MIPs you deleted from your workcenter are gray. To add them back into the workcenter, do the following:

1. Click the gray MIP you wish to add back to the workcenter.

2. Click Undelete MIP. The MIP turns blue.
To add MRC:
1. Click the Component you’d like to add an MRC to.
2. Click Add MRC.
3. On the right, enter the MRC Code.
4. Enter the Periodicity in the Periodicity edit box.
5. Enter the Start Quarter.
   
   **NOTE:** If you do not know the start quarter, ask your 3M Coordinator or consult the Joint Fleet Maintenance Manual to determine the start quarter. Your starting quarter is based on the date of your last major overhaul.
6. Modify any Mandatory Related Maintenance. See “To modify mandatory related maintenance” below.
7. Modify any Convenience Related Maintenance. See “To modify convenience related maintenance” below.

To delete MRC:
1. Click the MRC you’d like to delete.
2. Click Delete MRC. The MRC appears with a red dot, indicating it has been deleted.

To modify convenience related maintenance:
1. Click the MRC whose convenience related maintenance you’d like to modify.
2. Click Modify beneath the Convenience Related Maintenance edit box. The Convenience Related Maintenance dialog appears.
3. In the list box on the right, select the MRC that the MIP says should be associated.
4. Click OK.
5. Ensure that only the MRCs you wish to associate are highlighted, and click OK. All of the MRCs you’ve associated appear in the Convenience Related Maintenance edit box.

To modify cross MIP convenience related maintenance:
1. Click the MRC whose convenience related maintenance MRC is on another MIP.
2. Click Add Cross-MIP Related Maint. The Add Cross-MIP Related Maintenance dialog box appears.
3. In the list box on the left, click the MIP that contains the MRC you wish to associate. All the MRCs assigned to that MIP appear on the right.
4. In the right list box, click the MRC you wish to associate.
5. Click Add MRC Reference. The Convenience Related Maintenance dialog box reappears, and the MRC you added appears in the list box.
6. Ensure that only the MRCs you wish to associate are highlighted, and click OK. All of the MRCs you’ve associated appear in the Convenience Related Maintenance edit box.
To modify mandatory related maintenance:

1. Click the MRC whose mandatory related maintenance you’d like to modify.
2. Click Modify beneath the Mandatory Related Maintenance edit box. The Mandatory Related Maintenance dialog appears.
3. In the list box on the right, select the MRC that the MIP indicates should be associated.
4. Click OK.
5. Ensure that only the MRCs you wish to associate are highlighted, and click OK. All of the MRCs you’ve associated appear in the Mandatory Related Maintenance edit box.

To modify cross MIP mandatory related maintenance:

1. Click the MRC whose mandatory related maintenance MRC comes from another MIP.
2. Click Add Cross-MIP Related Maint. The Add Cross-MIP Related Maintenance dialog box appears.
3. In the list box on the left, click the MIP that contains the MRC you wish to associate. All the MRCs assigned to that MIP appear on the right.
4. In the right list box, click the MRC you wish to associate.
5. Click Add MRC Reference. The Mandatory Related Maintenance dialog reappears, and the MRC you added appears in the list box.
6. Ensure that only the MRCs you wish to associate are highlighted, and click OK. All of the MRCs you’ve associated appear in the Mandatory Related Maintenance edit box.

To show legend:

1. In the Revision Editor, click Show Legend.

To view details for MIPs, components and MRCs:

1. In the Revision Editor, select the MIP, component or MRCs whose details you wish to view.
2. The details appear on the right side of the screen.

FINALIZING THE REVISION

Once the revision is complete, it must be approved and finalized by the Department Head.
KEY TERMS

ACN Revision: An advanced change notice that comes out between Force Revisions.

Admin Revision: Performed if you have new equipment and need to add it to the boards.

DIT Revision (Documentation/Information Transmittal): Used to forward new issue and superceded PMS documentation between FRs. Provides PMS reference or status information and narrative replies to non-technical FBRs.

FBR Revision: A reply back from a feedback report.

Force Revision: Performed twice a year from the NAVY PMS CDs. Force Revisions will be covered in more depth in the Force Revision chapter at the back.

Revision Wizard: Provides step by step instructions for performing revisions. It also offers three different methods to perform revisions: from a NAVY PMS CD, from a Centralized Data Source and Manually.

Revision Editor: Enables the user to accept and reject MIPs and MRCs; add, delete and rename components; and add and delete MRCs to your workcenter. The Revision Editor also displays all of the information that has changed for each MIP and MRC.

ADDITIONAL RESOURCES

SKED 3.1 Online Help,
Maintenance Mode, Revision Changes Notification, Revision Wizard, Revision Editor

Ship’s 3M Manual,
OPNAVINST 4790C
Your journey through the SKED cycle is concluded. All of the actions discussed in Chapters 1-4, will repeat over and over again for years, until the ship is back in overhaul and ready to restart the cycle, as dictated by OPNAVINST 4790 and TYCOM directives.

You are at the pit-stop between the first and second section of the user’s guide. Throughout the first section, some topics referred you to later chapters for more information. The second half of this user’s guide will highlight the new features of SKED 3.1.

Continue on with Chapter 5-13 to expand your knowledge of SKED 3.1.
CHAPTER 5:  
FORCE REVISION

UNDERSTANDING FORCE REVISION

Force Revisions happen twice a year for the entire Fleet. During the Force Revision (FR), the most-up-to-date PMS documents are sent to the ships, subs and shore stations via the NAVY PMS CD-ROM. In previous versions of SKED, Force Revisions had been a tedious, time-consuming task. SKED 3.1 has completely revolutionized the way FRs are performed because of the following changes made to the application:

- SKED 3.1 remembers workcenter personalizations from the previous revision. If documents were rejected or deleted from the workcenter during the last revision, SKED 3.1 will never try to add it back to the workcenter, unless the document changes.

- The new Revision Changes Notification provides a snapshot of the changes that need to be made for the workcenter. It quickly shows which documents have been added, changed or deleted.

- The new Revision Wizard walks the user through each step of the revision, making it easier than ever before.

- The improved Revision editor flags documents that need to be reviewed, and consistent color-coding helps the user instantly know the exact state of every document. Changed periodicity and birthdate codes are also highlighted for quick reference.

SKED 3.1 provides three useful tools to aid the Force Revision process. The Revision Changes Notification, Revision Wizard and improved Revision Editor.

Using the Revision Changes Notification

The Revision Changes Notification dialog box instantly shows all the changes that are required for your workcenter during the Force Revision. Keep in mind that the changes cannot be applied automatically to your schedule. This is merely used as a gage to let you know the scope of the FR. A revision must be performed to have these changes take affect.

The dialog box is divided into two panes. On the left is a listing of all the MIPs and MRCs for your workcenter. On the right is a legend that clearly defines the different states of PMS documents. The color coding is no longer ambiguous like it was in previous versions of SKED. Just by looking at the icons, you can quickly tell if a document has been added, changed, deleted or previously rejected during the last revision.

To open the revision changes notification:

1. On the Tools menu, click PMS Changes Notification.

To print the revision changes notification:

1. Click Print on the dialog box.
Using the Revision Wizard

The Revision Wizard provides step by step instructions for performing revisions. It also offers three different methods to perform revisions: from a NAVY PMS CD, from a Centralized Data Source and Manually. The recommended method is from a centralized data source.

To open the revision wizard:
1. On the Tools menu, click Revision Wizard. The Revision Wizard appears.
2. Click Next. The Choose Revision Method dialog box appears.

To choose revision method:
1. Click Revision from Centralized Data Source.
   
   \textit{NOTE: This is the recommended way to perform a revision. However, revisions can be performed from the NAVY PMS CD or manually.}

2. Click Next. The Select Hull and Workcenter dialog box appears.

To select hull and workcenter:
1. From the Hull drop down menu, click your Hull Number.
2. From the Workcenter drop down menu, click your workcenter.
   
   \textit{NOTE: If your hull number or workcenter is not listed, select a similar hull or workcenter and you may customize it to suit your needs.}

3. Click Next. The Select MIPs dialog box appears.

To select MIPs:
1. Review the MIPs in the Workcenter list box. If a MIP is not used in your workcenter, click the MIP and then click the << button. The MIP appears in the Unused MIP list box and will not be added to your workcenter. If you need to add a MIP that is not listed, click Add Unlisted MIP. A list appears of all the MIPs on the CD in the Add Unlisted MIP dialog box. Select the ones you need to add and click Add MIP(s).

2. Click Next. The Revision Details dialog box appears.

To modify revision details:
1. In the Revision Type drop down menu, select the type of revision you are performing.
2. In the Revision Serial edit box, type the Revision Serial. For example, Equipment Removal for an Admin revision.

3. From the Revision Date drop down, select the date.
4. Click Next. The Review Revision Selections dialog box appears.

5. Review your selections. If you are satisfied, click Finish. This will open the Revision Editor.

6. If you are not satisfied, click Previous to make any changes.
Using the Revision Editor

The Revision Editor enables the user to accept and reject MIPs and MRCs; add, delete and rename components; and add and delete MRCs to your workcenter. The Revision Editor also displays all of the information that has changed for each MIP and MRC.

On the left of the Revision Editor there is a hierarchical representation of your workcenter. The first level of the hierarchy is the Workcenter Name. The second level lists all the MIPs contained in the workcenter. The third level lists all the components that fall under that MIP. The fourth level displays all the MRCs listed on the component row.

Icons appear next to items in the outline. These icons provide valuable information that will help you make more informed decisions during the revision and are quickly defined by clicking Show Legend.

The right side of the screen provides all of the detailed information available for the MIPs, Components and MRCs. At the top, the icon is explained as well to help you understand the status of that particular item. Any changes that have been made are highlighted for easy recognition.

Color coding makes it easy to tell what state the document is in. This is a big change for SKED 3.1 and is designed to make performing revisions quick and painless. Revisions can be performed in a fraction of the time it used to take because SKED remembers every change you made during the last revision, and doesn’t make you repeat any of those actions.
To add component:

1. On the Tools menu, click Revision Editor.
   
   **NOTE:** If you do not see Revision Editor as an option, you are probably not in Revise Mode.

2. Click the MIP you’d like to add a component to.

3. Click Add Component.

4. On the right, enter the Component Name in the Component Name edit box.
   
   **NOTE:** If you add a new component, you also need to add the appropriate MRCs to that component.

To delete component:

1. Click the Component you’d like to delete.

2. Click Delete Component. The Component appears with a red icon and all the MRCs are red as well.

To rename component:

1. Click the Component you’d like to rename.

2. On the right, type the new name in the Component Name edit box.

To copy component:

1. Click the Component you’d like to copy.

2. Click Copy Component. The Component appears with a green dot, indicating that this is a new component for your workcenter.

To add MIP:

1. Select your workcenter at the top of the tree.

2. Click Add MIP.

3. On the left, enter the MIP Code.
   
   **NOTE:** Do not put spaces in the MIP Code or Date code.

To delete MIP:

1. Click the MIP you’d like to delete.

2. Click Delete MIP. The MIP appears with a red dot, indicating it has been deleted.
   
   **NOTE:** If you wish to undelete the MIP, click Undelete MIP. The folder will turn blue.

To add a deleted MIP back to the workcenter:

**NOTE:** MIPs you deleted from your workcenter are gray. To add them back into the workcenter, do the following:

1. Click the gray MIP you wish to add back to the workcenter.

2. Click Undelete MIP. The MIP turns blue.

To add MRC:

1. Click the Component you’d like to add an MRC to.

2. Click Add MRC.
3. On the right, enter the MRC Code.
4. Enter the Periodicity in the Periodicity edit box.
5. Enter the Start Quarter.
   
   **NOTE:** If you do not know the start quarter, ask your 3M Coordinator or consult the Joint Fleet Maintenance Manual to determine the start quarter. Your starting quarter is based on the date of your last major overhaul.
6. Modify any Mandatory Related Maintenance. See “To modify mandatory related maintenance” below.
7. Modify any Convenience Related Maintenance. See “To modify convenience related maintenance” below.

**To delete MRC:**
1. Click the MRC you’d like to delete.
2. Click Delete MRC. The MRC appears with a red dot, indicating it has been deleted.

**To modify convenience related maintenance:**
1. Click the MRC whose convenience related maintenance you’d like to modify.
2. Click Modify beneath the Convenience Related Maintenance edit box. The Convenience Related Maintenance dialog appears.
3. In the list box on the right, select the MRC that the MIP says should be associated.
4. Click OK.
5. Ensure that only the MRCs you wish to associate are highlighted, and click OK. All of the MRCs you’ve associated appear in the Convenience Related Maintenance edit box.

**To modify cross MIP convenience related maintenance:**
1. Click the MRC whose convenience related maintenance MRC is on another MIP.
2. Click Add Cross-MIP Related Maint. The Add Cross-MIP Related Maintenance dialog box appears.
3. In the list box on the left, click the MIP that contains the MRC you wish to associate. All the MRCs assigned to that MIP appear on the right.
4. In the right list box, click the MRC you wish to associate.
5. Click Add MRC Reference. The Convenience Related Maintenance dialog box reappears, and the MRC you added appears in the list box.
6. Ensure that only the MRCs you wish to associate are highlighted, and click OK. All of the MRCs you’ve associated appear in the Convenience Related Maintenance edit box.

**To modify mandatory related maintenance:**
1. Click the MRC whose mandatory related maintenance you’d like to modify.
2. Click Modify beneath the Mandatory Related Maintenance edit box. The Mandatory Related Maintenance dialog appears.

3. In the list box on the right, select the MRC that the MIP indicates should be associated.

4. Click OK.

5. Ensure that only the MRCs you wish to associate are highlighted, and click OK. All of the MRCs you’ve associated appear in the Mandatory Related Maintenance edit box.

To modify cross MIP mandatory related maintenance:

1. Click the MRC whose mandatory related maintenance MRC comes from another MIP.

2. Click Add Cross-MIP Related Maint. The Add Cross-MIP Related Maintenance dialog box appears.

3. In the list box on the left, click the MIP that contains the MRC you wish to associate. All the MRCs assigned to that MIP appear on the right.

4. In the right list box, click the MRC you wish to associate.

5. Click Add MRC Reference. The Mandatory Related Maintenance dialog reappears, and the MRC you added appears in the list box.

6. Ensure that only the MRCs you wish to associate are highlighted, and click OK. All of the MRCs you’ve associated appear in the Mandatory Related Maintenance edit box.

To show legend:

1. In the Revision Editor, click Show Legend.

To view details for MIPs, components and MRCs:

1. In the Revision, select the MIP, component or MRCs whose details you wish to view.

2. The details appear on the right side of the screen.

FINALIZING THE FORCE REVISION

Once the revision is complete, it must be approved and finalized by the Department Head.
**KEY TERMS**

**Force Revision:** Performed twice a year from the NAVY PMS CDs. Force Revisions will be covered in more depth in the Force Revision chapter at the back.

**Revision Changes Notification:** Shows all the changes that are required for your workcenter during the Force Revision. Should be used as a gage to let you know the scope of the FR.

**Revision Wizard:** Provides step by step instructions for performing revisions. It also offers three different methods to perform revisions: from a NAVY PMS CD, from a Centralized Data Source and Manually.

**Revision Editor:** Enables the user to accept and reject MIPs and MRCs; add, delete and rename components; and add and delete MRCs to your workcenter. The Revision Editor also displays all of the information that has changed for each MIP and MRC.

**ADDITIONAL RESOURCES**

SKED 3.1 Online Help,
Maintenance Mode, Revision Changes Notification, Revision Wizard, Revision Editor

Ship’s 3M Manual,
OPNAVINST 4790C
CHAPTER 6:
R-CHECKS

UNDERSTANDING R-CHECKS

R-Check events are situational checks. Meaning, they are performed when certain pre-determined conditions are met. In SKED 3.1 there are two types of events:

**Global:** This event is triggered by the 3M Coordinator and affects every workcenter on the ship. An example of a Global Event is “24 Hours Prior to Underway.”

**Local:** This is triggered by the Workcenter Supervisor and only affects his workcenter.

Each type of event has situational MRCs that the Workcenter Supervisor must associate to the event, according to the MIP. SKED 3.1 enables the Workcenter Supervisor to associate a group of situational MRCs with the same scheduling requirements to a single event, as opposed to associating each MRC to the event separately. This is a great time saving measure.

The Event Manager is used to associate the MRCs to the events. Events are added, modified and deleted by the 3M Coordinator and the Workcenter via the Event Editor.

Using the Event Manager

The Event Manager is only accessible by the 3MC and the Workcenter Supervisor. This is where MRCs are selected and associated to corresponding events.

**To select MRCs to associate to events:**

1. On the R-Checks menu, click Event Manager. The Event Manager dialog box displays.
2. From the Event Title list, click the event to which you wish to associate MRCs.
3. Click Select MRCs. The Select Event MRCs dialog box displays.
4. Click all the MRCs you wish to associate to this event. The icon will turn green when you click it.
   
   **NOTE:** A green icon indicates it will be associated to the check, and a white box indicates it will not be associated.

5. Click Close.
Using the Event Editor

The Event Editor is where the 3M Coordinator or Workcenter Supervisor can add, modify, and delete R-check events. 3M Coordinators add, modify and delete Global events, while Workcenter Supervisors work with Local events.

To add a local event:
1. On the R-Checks menu, click Event Editor. The Event Editor dialog box appears.
2. Click Add Event. The Create New Event dialog box appears.
3. In the Event Title edit box, enter the name of the event.
4. In the Event Description edit box, enter a brief sentence describing the event.
5. Click Local Event.
6. Click OK. The new Event appears in the Event Title grid.

To delete a local event:
1. On the R-Checks menu, click Event Editor. The Event Editor dialog box appears.
2. From the list, click the Event Title you wish to delete.
3. Click Delete. A Confirm Deletion dialog box displays.
4. Click Yes.

To modify an event:
1. On the R-Checks menu, click Event Editor. The Event Editor dialog box appears.
2. From the list, click the Event Title you wish to modify.
3. Click Modify Title. The Modify Event & Description dialog box appears.
4. In the Event Title edit box, modify the name of the event.
5. In the Event Description edit box, modify the description.
6. Click OK.

Triggering Local Events

Once events are created in the Event Editor, and the MRCs are associated to the event, the Workcenter Supervisor triggers events that only affect his workcenter. Once the event is triggered, the event will be added to the schedule.

To trigger a local event:
1. On the R-Checks menu, click Trigger Local Event. The Trigger Local Event dialog box appears.
2. From the Event Name list, click the Event you wish to trigger.
3. On the calendar, select the month and day you wish to trigger the event.
   
   **NOTE:** To change months, click the < and > buttons.
4. Click OK. A Confirm Event Activation dialog appears.
5. Click Yes, if you are sure you wish to trigger the event. Click No if you are not sure.
**KEY TERMS**

**Event Editor:** This is where 3M Coordinators and Workcenter Supervisors add, modify and delete Global events.

**Event Manager:** Enables the 3MC or Workcenter Supervisor to associate MRC checks to events.

**R-Checks:** Situational checks that are performed “as required.”

**Global Event:** This event is triggered by the 3M Coordinator and affects every workcenter on the ship. An example of a Global Event is “24 Hours Prior to Underway.”

**Local Event:** This is triggered by the Workcenter Supervisor and only affects his workcenter.

---

**ADDITIONAL RESOURCES**

**SKED 3.1 Online Help,**
R-Checks, Event Manager, Event Editor

**Ship’s 3M Manual,**
OPNAVINST 4790C
CHAPTER 7:
REPORTS

UNDERSTANDING REPORTS
Reports are a vital part of SKED. They enable the Fleet to keep track of which pieces of equipment PMS checks should be performed on, how much of the PMS is actually being accomplished, who is performing the maintenance and many other types of information. There are nine different types of reports:

- Shipwide PMS Performance Report
- To-Do-List Report
- EGL Report
- PMS Check Viewer
- PMS Performance Report
- Forecasting Report
- 13 Week Report
- Flip Page Report
- MRC Accomplishment Report

Shipwide PMS Performance Report
With the new Shipwide PMS Performance, you no longer have to manually combine all the PMS Performance Reports and spend hours generating a shipwide report yourself. This feature will save you tons of time.

You can generate a PMS Performance Report for the entire ship, or break it down by Department or Division. There are now two styles of RARs. The traditional style counts the checks on the schedule only once and does not take into account EGLs. The Equipment Based RAR counts EGL checks one time for each piece of equipment on the EGLs. This gives a more true representation of the maintenance being accomplished.

To generate a shipwide PMS report:

2. From the Start Date drop down menu, select the start date for which you wish to generate the Shipwide PMS Performance Report.
3. From the End Date drop down menu, select the end date for which you wish to generate the Shipwide PMS Performance Report.
4. From the RAR Report drop down menu, select either Equipment-Based RAR which counts all pieces of equipment on an EGL, or select Traditional RAR which only counts each check on the schedule once.
5. From the Report drop down menu, select the Scope for which you wish to generate the Shipwide PMS Performance Report. The choices are Shipwide, Department or Division. If you choose Department or Division, then you must select the Report Level from the Report Level drop down menu.
6. Click Generate Report. A progress bar will appear, and then the Shipwide PMS Performance Report displays.
7. Click Close if you are done. Click Back if you wish to generate another Shipwide PMS Performance Report.
**EGL Report**

The EGL Report shows you what equipment you’re supposed to be performing PMS checks on and displays a list of all the EGLs in your workcenter, complete with MIP numbers, Component names, MRC codes and EGL numbers.

EGLs in SKED 3.1 are generated automatically from the equipment associations made to a component row. MRCs associated with more than one piece of equipment are considered an EGL in these reports.

**To view EGL report:**

1. On the Reports Menu, point to EGL Report.
2. Click View EGL Report.

---

**PMS Performance Report**

The new and improved PMS Performance Report finally gives a true representation of the maintenance you are accomplishing.

The RAR rating is now divided into two values. Instead of only using the Traditional RAR you are used to, the new Equipment Based RAR gives a more accurate reading of the actual maintenance you’ve performed by utilizing the Split Check feature. The Traditional RAR robs you of higher accomplishment ratings, while the new Equipment Based RAR gives you credit for the 8 out of 10 EGLs you do complete.

Typically PMS Performance Reports go to the Executive Officer, via chain of command. Workcenter Supervisors would print this report and give it to the Division Officer for review. The Division Officer gives it to the Department Head for review and from there it goes to the 3MC. 3MC reviews it and gives it to the Executive Officer.

**To generate the PMS Performance Report:**

2. From the Quarter drop down menu, select the quarter for which you wish to generate the PMS Performance Report.
3. From the Week drop down menu, select the week for which you wish to generate the PMS Performance Report. The values are automatically updated for the given time frame.
4. Click Print.
13 Week Report

This report displays all the checks that are scheduled for completion in a particular week. It is typically printed and posted in the workcenter. As the maintenance men do their jobs, they come back and sign this report. The following Monday, this report is given to the Division Officer for his signature. He has to sign this so he is aware of what PMS was accomplished in the previous week. The Division Officer should also receive the current weeks’ 13 Week Report so he knows what is expected to be accomplished.

To generate a 13 week report:

2. From the Quarter drop down menu, select the Quarter for which you wish to generate a 13 Week Report.
3. From the Week of drop down menu, select the Week for which you wish to generate a 13 Week Report.
4. If you want to display who is responsible for the maintenance, click the Show maintenance responsibilities from the weekly schedule check box. A check in the box indicates that the information will display.
5. Click Print.

MRC Accomplishment Report

The MRC Accomplishment Report helps you quickly see the status of all the maintenance for your workcenter. Icons on the left, combined with the accessible Legend, make it very simple to see which maintenance is completed, overdue, deleted, and which are in the optimal range to be accomplished.

NOTE: This feature is not meant to validate schedules. It is intended to be a helpful guide.

This report provides the status of the MRC, the component name, MRC code, periodicity and the date this maintenance was last performed. The Minimum date shows the beginning of the range when this maintenance should be completed, and the Maximum date shows the absolute last day the maintenance can be accomplished and still be within periodicity.

NOTE: The Minimum and Maximum dates are based on logical intervals for periodicity, not on intervals set by OPNAVINST 4790.

To view the MRC accomplishment report:

2. From the As of drop down menu, select the month and week. The report displays.

To-Do-List Report

This report shows all the maintenance responsibilities that are scheduled within a given time frame, by entire Quarter or a given week. It also displays maintenance responsibilities for an individual crew member.

To generate the To-Do-List report:

2. From the Quarter drop down menu, select the quarter you wish to generate a To-Do-List Report.
3. Select a Date Range. Click Entire Quarter, or click Week Range depending on what you want. If you click Week Range, from the first Week Range drop down menu, select a starting week. From the second Week Range drop down menu, select an ending week.

4. Click All Maintenance Responsibilities if you want to view all the maintenance scheduled for the given time frame. Click Specific Crew Member, and then select the specific crew member from the drop down list.

   **NOTE:** If the Specific Crew Member option is grayed out, this indicates that no maintenance has been assigned to a crew member for the given time frame. See the Assign Maintenance Responsibilities section of the Revise Quarter chapter for more information.

5. Click Print.

**PMS Check Viewer**

This report shows all the PMS checks that have been scheduled over a given time frame, for all crew members, or for an individual, and lets you filter those checks by various attributes.

There are 6 different attribute filters. You can select as many or as few of these as you’d like:

- **Display All Marked Checks:** Select this filter to show those checks that have been marked on the board.
- **Display All Unmarked Checks:** Select this filter to show those checks that have not been marked on the board.
- **Display Split Checks:** Select this filter to show checks that have been split.
- **Display Partial Checks:** Select this filter to show checks that have only been partially completed but satisfied the main intent of the check.
- **Display Checks with Spot Checks:** Select this filter to show checks that have had spot checks.
- **Display Checks with parts not in supply:** Select this filter to show checks that do no have the parts necessary to complete the check in supply.

**To generate the PMS check viewer report:**

1. On the Reports menu, click PMS Check Viewer. The PMS Check Viewer dialog box displays.
2. From the Quarter drop down menu, select the quarter for which you wish to generate the report.
3. From the Week drop down menu, select the week for which you wish to generate the report.
4. From the Maintenance Man drop down menu, select the maintenance man for which you wish to generate the report.
5. Check as many of the Attribute filters as you’d like. If a check box appears next to a filter, it indicates that the filter will be applied to the search.
6. Click Perform Search. The Search Results dialog box displays.
7. Click Close if you are done. Click Back if you’d like to generate another report.
**Forecasting Report**

This report forecasts the maintenance materials that are required for this workcenter over a given time frame. The report will display all the test equipment, materials, parts, tools and miscellaneous items that are required to accomplish PMS over the scheduled period of time.

**To generate a forecasting report:**

1. From the Start drop down menu, click the Quarter and Week for which you want the Forecasting report to start.
2. From the End drop down menu, click the Quarter and Week for which you want the Forecasting report to end.
3. From the MIPs drop down menu, click the MIP you wish to include in the report.
   
   **NOTE:** You can select All MIPs to include all the MIPs in the report.
4. From the Personnel drop down menu, click the Personnel you wish to include in the report.
   
   **NOTE:** You can select All Personnel to display all maintenance related to personnel.
5. Click Ok. The Maintenance Forecasting dialog box displays. This contains an outline on the left whose hierarchy is broken down by Week, MIP and Workcenter.
6. On the outline on the left, click the Week, MIP or Workcenter by which you wish to filter the information. Whichever item you click on the outline, the information that displays in the grid on the right will only relate to that item. For instance, if you click the week of 10/07/2007, you will only see Materials needed for checks that are going to be performed during the week of 10/07/2007.
7. You can select the tabs across the top to also filter the information by All, Test Equipment, Materials, Parts, Tools and Miscellaneous. For example, if you have the week of 10/07/2007 selected in the outline and then select the Test Equipment tab, the information in the grid will only display the test equipment needed for maintenance for the week of 10/07/2007.
8. Click Print.

**Flip Page Report**

This report shows flip page entries for a given quarter or a given week. Flip Page entries give reasons for why maintenance was not accomplished.

**To generate a flip page report:**

2. From the Quarter drop down menu, select the quarter for which you wish to generate the Flip Page Report.
3. From the Week of drop down menu, select the specific week for which you wish to generate the Flip Page Report. Any Flip Page reports for the specified time frame display in the grid.
4. Click Print.
To edit the reason the flip page entry was created:

1. Once you have generated a Flip Page report as described above, click the Flip Page Report in the grid whose reason you’d like to edit.
2. Click Edit Reason. The Enter Reason Not Completed dialog box appears.
3. Type the new reason in the edit box.
4. Click OK.

**KEY TERMS**

**13 Week Report:** Contains all the checks that are scheduled for completion in a particular week.

**EGL Report:** Shows you what equipment you’re supposed to be performing PMS checks on.

**Flip Page Report:** Shows flip page entries for a given quarter or given week.

**Forecasting Report:** Forecasts the maintenance materials that are required for this workcenter over a given time range.

**MRC Accomplishment Report:** Quickly shows the status of all the maintenance for your workcenters.

**PMS Check Viewer:** Shows all PMS checks that have been scheduled over a given time frame, for all crew members, or for an individual, and lets you filter those checks by various attributes.

**PMS Performance Report:** Combines the values of both the RAR and ACF reports in one simple format. This is a new format that gives more accurate ratings than ever before.

**Shipwide PMS Report:** Automatically generates a Shipwide Report for a given time frame, by different RAR Report Styles, different scopes and levels.

**To-Do-List Report:** Shows all the maintenance responsibilities that are scheduled within a given time frame, by entire Quarter or a given week. It also displays maintenance responsibilities for an individual crew member.

**ADDITIONAL RESOURCES**

**SKED 3.1 Online Help,**
Reports

**Ship’s 3M Manual,**
OPNAVINST 4790C
CHAPTER 8:  
PMS BROWSER

UNDERSTANDING THE PMS BROWSER

A new feature of SKED 3.1 is the embedded PMS Browser. In previous versions of SKED, a second application was required to view all the MIPs and MRCs at one time. The new PMS Browser displays and prints all the MIPs and MRCs in your Workcenter on demand. The PMS Browser is divided into two panes. The pane on the left side of the screen contains a tree outline of all the MIPs and MRCs in the workcenter. Clicking the items causes the applicable card to appear in the right pane.

The printing feature inside the PMS Browser can help save time by performing batch prints. A batch print is a group of pages that can be printed at one time. There are three types of batch prints:

- Print all documents listed for the workcenter
- Print documents that are on the schedule
- Print documents that have changed since the last FR

To open the PMS Browser:

1. Click the Binoculars button on the bottom left side of the screen.

To view MIP:

1. Click the Binoculars button on the bottom left side of the screen. The PMS Browser opens.
2. On the left pane, click the MIP you wish to view.
3. The MIP appears in the right pane.

To view MRC:

1. Click the Binoculars button on the bottom left side of the screen. The PMS Browser opens.
2. On the left pane, click the plus sign beside the MIP that contains the MRC you wish to view.
3. Click the MRC you wish to view. The MRC appears in the right pane.

To print a MIP:

1. Click the Binoculars button on the bottom left side of the screen. The PMS Browser opens.
2. On the left pane, click the MIP you wish to print. The MIP appears in the right pane.
3. On the toolbar, click Print. The Print Preview dialog box appears.
4. If everything looks the way you want, click Print. The Print dialog box appears.
5. Select the printer and which pages you wish to print.
6. Click Print.
To print an MRC:

1. Click the Binoculars button on the bottom left side of the screen. The PMS Browser opens.
2. On the left pane, click the plus sign beside the MIP that contains the MRC you wish to print.
3. Click the MRC you wish to print. The MRC appears in the right pane.
4. On the toolbar, click Print. The Print Preview dialog box appears.
5. If everything looks the way you want, click Print. The Print dialog box appears.
6. Select the printer and which pages you wish to print.
7. Click Print.

To perform a batch print:

1. Click the Binoculars button on the bottom left side of the screen. The PMS Browser opens.
2. On the toolbar, click Batch Print. The PMS Cards Batch Printing dialog box appears.
3. Select one of these three choices: Print all PMS documents listed for my workcenter, Print only PMS documents that have changed for my workcenter, and Print only PMS documents that are on the workcenter schedule.
4. Click Start Printing. The Print dialog box appears.
5. Select the printer and click Print.

To search for a MIP or MRC:

1. Click the Binoculars button on the bottom left side of the screen. The PMS Browser opens.
2. On the Navigate menu, click PMS Card Search. The Search dialog box appears.

NOTE: You can also click Search on the toolbar to access the Search dialog box.

3. By default, the MIP Search tab is selected. If you wish to search for an MRC, click the MRC Search tab. Both tabs function the same, except one searches for MIPs and one searches for MRCs.
4. You can search by Nomenclature or Number. If you wish to search by Nomenclature, enter the nomenclature in the Nomenclature edit box, and click Search Now. To search by number, enter the MIP Number in the MIP number edit box, or enter the MRC Number in the MRC Number edit box. Click Search Now.
5. Any cards that match your search will display in the grid below. Scroll through the list and find the one you wish to view.
6. Select the card you wish to view and click View Selection. The card displays in the right-side pane.

To navigate back and forward through the cards you view:

1. To navigate back, click Back on the toolbar.
2. To navigate forward, click Forward on the toolbar.

To return to SKED 3.1:

1. Click the Clock button on the bottom left side of the screen.
### KEY TERMS

| **Batch Print:** | A group of pages that can be printed at one time. |
| **PMS Browser:** | An embedded application that displays and prints PMS cards. |

### ADDITIONAL RESOURCES

SKED 3.1 Online Help,  
PMS Browser
CHAPTER 9:
LIST VIEW

UNDERSTANDING THE LIST VIEW

In previous versions of SKED, schedules could only be viewed in three ways: Cycle, Quarter and Weekly view. SKED 3.1 gives offers a whole new way to view your schedules.

Each row of the List View corresponds to a check on the board. It’s sorted by date, and the week you have currently selected is automatically highlighted. This makes it easy to tell which checks need your immediate attention. Icons on the board provide the following information:

Check Marking: Instantly see how the check is marked on the board. You can also mark this board just as you would the quarter and weekly view. Simply click the appropriate mark tool on the toolbar, and click the left most column of the row you wish to mark. The mark will appear.

Spot Check Indicator: If a spot check has been performed on the check, an icon appears in the second column from the left. Satisfactory checks are indicated by a blue circle with a check mark. Unsatisfactory checks are indicated by a red circle with a check mark, and Partial spot checks are indicated by a blue circle with a check mark.

Partial Check Indicator: A partial check is defined as a check that did not accomplish every single step listed on the MRC, but the “spirit” of the check was satisfied. For example, if the check was to change the air filter on a motor, and you changed the filter, but the cover was not there so you could not complete the last step on the MRC which was to put the cover back on.

Split Check Indicator: This icon indicates that this check has been split. This is a new feature for SKED 3.1. This means that EGL checks were split into two separate checks. You can now take credit for the maintenance you completed and allows you to defer the checks that were not accomplished.

Missing Parts Indicator: This is a great tool. At a glance, you can see if parts are missing for upcoming maintenance. Having this information so readily available will help you better manage your schedule.

NOTE: This feature will only work for those running SKED 3.1 in Server Mode with OMMS-NG enabled.

The Man Hours column shows exactly how many hours it will take to complete a check. It even factors in EGLs to truly reflect the amount of time it will take to complete a check. The Crew column automatically shows you which crew member is responsible for each check on the board. The Date column lets you know when the check is scheduled to be completed. The MIP, Component and MRC columns display the MIP code, component name and MRC code respectively.

On top of all these great features, you can perform all the same tasks you previously could on the quarter and weekly schedules. Right-click any check on the board to unveil several commands.
To open the list view:

1. On the toolbar, click List View.

To mark up the list view:

1. On the toolbar, click the mark tool you wish to use.
2. Click the Check Marking column (the left most column) on the row you want to mark. The mark appears in the column.

### Using the Split Check Feature

The Split Check feature is a new concept in SKED 3.1. Split checks can be performed on a quarter, weekly or List View board. The Split Check Feature allows you to split an EGL check in order to get credit for the EGL items that you are able to complete and to defer the ones that you are not able to accomplish. This will result in higher accomplishment ratings and gives a more accurate representation of the actual maintenance being performed. It is accessed by right-clicking an EGL check and clicking Split Check.

To split a check:

1. On the toolbar, click List View.
   
   **NOTE:** You can also perform a split check on the quarter and weekly boards.

2. Right-click an EGL check.
3. Click Split Check. The Split Check dialog box appears with all the equipment items listed.
4. Press CTRL and select each EGL you were able to complete.
5. Click OK. On the schedule, two checks will appear. One will be marked as completed, and the other check can be rescheduled or deferred as required.

---

### KEY TERMS

**List View:** A new board type in SKED 3.1. Each row corresponds to a check on the board, icons provide information regarding the status of the check.

**Split Check:** When all EGLs cannot be accomplished, you can divide the EGL into checks that were completed and defer the checks that weren’t completed.

### ADDITIONAL RESOURCES

**SKED 3.1 Online Help,**
New List View, Split Check Feature
CHAPTER 10:
FEEDBACK REPORTS

UNDERSTANDING FEEDBACK REPORTS

Feedback Reports are a valuable communication tool between the ships and the FTSCs. They help inform the FTSCs of what the ship needs and provide a means for the FTSCs to respond to those needs.

There are two tools that assist with Feedback Reports:

**FBR Wizard:** This makes creating FBRs as simple as a few clicks, and is the recommended method for creating feedback reports. SKED automatically fills in 75% of all the information.

**FBR Manager:** This allows you to review, approve and transmit FBRs.

FBRs do the following:

- Report deficiencies on MRCs
- Request or decline PMS coverage
- Submit for changes in PMS documents
- Request Split MIPs
- Request Replacement MRC, i.e. classified, one issued between Forces Revisions

FBRs must be approved by four signatures before they can be transmitted:

- **Originator:** The person who submits the FBR.
- **Division Officer:** Division Officer in charge of originator.
- **Department Head:** Department Head of the above Division Officer
- **3M Coordinator**

To create a feedback report from the board:

1. Right-click a check on the board.
2. Click Create Feedback Report. The FBR Wizard opens.
3. Follow the instructions.
Using the FBR Wizard

The FBR will help generate an electronic feedback report. There are two types of feedback reports that can be generated:

**Category A:** These FBRs are used to request information, such as new or classified copies of MIPs and MRCs.

**Category B:** These are used for more technical issues relating to MIPs and MRCs.

To open the FBR Wizard:

2. Click Yes, I want to create a Feedback Report. The Provide Workcenter Information dialog box appears.

To provide workcenter information:

1. Type the name of your workcenter in the Workcenter Name edit box.
2. Click Next. The Select Category Type dialog box appears.

To select category type:

1. If you have an information request, click Category A.
2. If you have a technical issue, click Category B.
3. Click Next. The Select FBR Destination dialog box appears.

To select FBR destination:

*NOTE:* Both Category A and Category B Feedback Reports are sent to FTSCCLANT or FTSCPAC. Previously, Category B Feedback Reports were sent to the Type Commander, but this is no longer the case.

1. Select FTSCCLANT or FTSCPAC from the drop down menu depending on where you’d like the FBR to be sent.
2. Depending on the type of FBR, the problem description is automatically filled in.
3. Click Next. The Enter PMS Equipment Specification dialog box appears.

To enter PMS equipment specifications:

1. In the MIP edit box, enter the MIP number.
2. In the Component edit box, enter the Component Name.
3. In the MRC edit box, enter the MRC code.
4. In the Equipment Identifier edit box, enter the Equipment information.
5. Click Next. The Add Remarks dialog box appears.

To add remarks:

*NOTE:* You must type something in the Remarks edit box in order to proceed with the FBR Wizard.

1. Type the description in the edit box.
2. Click Next. The Submit Report dialog box appears.
To print report:

**NOTE:** You can print the FBR and mail it to the appropriate FTSC center.

1. Click Print. The Print dialog box appears.
2. Choose the Printer and click Print.
3. Click Exit.

To submit report:

1. Click Submit.
2. Click Exit.

**Using the FBR Manager**

The Feedback Manager enables the user to review, approve and transmit FBRs. The FBR Manager is divided into two panes, a toolbar and four tabs.

From the toolbar, you can create, delete, and transmit feedback report. You can make feedback reports urgent, verify that every step has been completed by viewing the Feedback Checklist, change the serial number counter, create transmit file, and cancel the transmission. Ship information can be modified, the grid can be refreshed, and you can navigate backward and forward through all feedback reports listed in the FBR manager. You can also print FBR’s from here as well.

There are four tabs in the FBR Manager:

- **General:** Shows the Serial #, Status, Date In, Date Out, MIP, MRC, APL, Category, System or Component, Originator, Workcenter, and destination of the FBR. This is where your FBRs are reviewed and approved.

- **Remarks:** Contains the description of the problem that was entered into the FBR Wizard. You can edit the remarks if necessary.

- **Response:** This will display any response received. If something is contained in this field, the Status on the grid will read “Response.”

- **Action Taken:** This is where you’d describe any action the ship took related to the response.

On the left side of the FBR Manager, all of the FBRs are listed in a grid. This list, or grid, can be filtered by using the Workcenter and Originator drop down menus. The list displays the Serial number, Date, Workcenter Name and the Status. Clicking an FBR in the list causes the information from that FBR to appear on the right, under the General Tab. There are 5 different types of status:

- **Under Review:** This means that this FBR has not been approved yet, and is in the process of being reviewed.

- **Review Completed:** This means the FBR has been reviewed, but not yet transmitted.

- **Awaiting X-Fer:** This means that the FBR has been approved and the transmittal file has been created, but it has not left the ship.

- **Transmitted:** This means the FBR has left the ship and gone to the FTSCs.

- **Response:** Indicates that the FTSCs have responded to the FBR. Responses are viewed in the Response tab on the right.
The Workcenter drop down menu contains a list of all the workcenters on the ship and helps filter the FBRs. Clicking an individual workcenter will display only the FBRs related to that workcenter in the grid below. The Originator drop down menu contains a list of all personnel who have created FBRs and helps filter the FBRs. Clicking an individual displays only the FBRs created by that individual in the grid below.

Feedback Reports must be approved by the Division Officer, Department Head and 3MC before they can be submitted. Signatures can be done electronically. If any changes need to be made to the FBR, all the signatures must be cleared by the Division Officers and Department Head.

The Workcenter Supervisor is only able to perform the following functions in the FBR Manager:

To open the FBR Manager:
1. On the Tools menu, click FBR Manager.

To create a new feedback report:
NOTE: Make sure the General Tab is selected.
1. On the Tools menu, click FBR Manager.
2. Click New Feedback on the toolbar. A new entry appears on the list.
3. On the General tab, select the FBR’s destination from the To: drop down menu. By default, FTSCLANT is selected.
4. Enter the Workcenter name in the Workcenter edit box.
5. Enter the MIP code in the MIP edit box.
6. Enter MRC number in the MRC edit box.
7. Enter APL in the APL edit box.
8. Enter System, Subsystem or Component.
9. Select the category of the FBR.
10. Click the Remarks tab.
11. Type a description of the problem in the Remarks edit box.

To make an FBR urgent:
1. On the Tools menu, click FBR Manager.
2. Select the FBR from the list that needs to be marked as Urgent.
3. Click Urgent FBR from the toolbar. URGENT appears in large yellow letters on the General tab.
4. The FBR must have all of the approval signatures and required information supplied before it can be transmitted.
5. Once the FBR status is changed to Review Complete, a new Transmit Feedback button appears on the toolbar. Click Transmit Feedback. The Assign Date/Time group dialog box.
6. Enter the Date/Time group.

NOTE: Adhere to the Format. For example, 051500ZFEB03.
7. The Status of the FBR will change to Awaiting Xfer.
To delete a feedback report:
1. On the Tools menu, click FBR Manager.
2. Select a Feedback Report from the list.
3. On the toolbar, click Delete Feedback. The Delete Confirmation dialog box appears.
4. Click Yes.

To edit remarks:
1. On the Tools menu, click FBR Manager.
2. Click the FBR whose remarks you wish to edit.
3. Click the Remarks tab.
4. Edit the remarks as needed.

To document actions taken by the ship:
1. On the Tools menu, click FBR Manager.
2. In the grid, click the FBR that you wish to document the action taken by the ship in relation to that FBR.
3. Click the Action tab on the right.
4. In the edit box, describe the action taken by the ship.
5. Click Close.

To refresh grid:
1. On the toolbar, click Refresh Grid.

To check FBR Status:
1. On the Tools menu, click FBR Manager.
2. Click the FBR whose status you wish to check.
   NOTE: You may need to use the Workcenter drop down menu and Originator drop down menu to select a specific workcenter and originator.
3. The Status appears in the Status column and is also displayed on the General tab.

To print feedback report:
1. On the Tools menu, click FBR Manager.
2. Click the FBR in the grid you wish to print.
3. Click Print Feedback.
**KEY TERMS**

**Category A Feedback:** These FBRs are used to request information, such as new or classified copies of MIPs and MRCs.

**Category B Feedback:** These are used for more technical issues relating to MIPs and MRCs.

**FBR Wizard:** This makes creating FBRs as simple as a few clicks, and is the recommended method for creating feedback reports. SKED automatically fills in 75% of all the information.

**FBR Manager:** This allows you to review, approve and transmit FBRs.

---

**ADDITIONAL RESOURCES**

SKED 3.1 Online Help,
Feedback Reports, FBR Wizard, FBR Manager

OPNAVINST 4790.4C,
The Planned Maintenance Chapter
CHAPTER 11:  
RESTORE A WORKCENTER

WHEN TO RESTORE A WORKCENTER
Restoring workcenter databases is an integral part to SKED’s functionality. In case of hardware failure, power loss while saving a workcenter, or other events that may corrupt or delete a workcenter, restoring the SKED database from a backup will get you back up and running quickly.

Using the Restore Workcenter Wizard
The Restore Workcenter Wizard allows you to restore a workcenter from an external backup file. Before you may restore from an external backup file, you must first delete the existing workcenter.

To perform an external restore:
1. On the File menu, click External Restore Workcenter. The Restore Workcenter dialog box appears.
2. Click I am ready to restore my workcenter. The Select Workcenter dialog box appears.
3. Click Browse and select the external source where the workcenter you wish to restore is located.
4. Click the workcenter and click Open. The data path appears in the Workcenter Path edit box.
5. Click Next. The Select Owner Information dialog box appears.
6. From the Division drop down menu, click the Division.
7. From the Workcenter Supervisor list box, select the Workcenter Supervisor.
8. Click Next. The Select Restoration Destination dialog box appears.
9. Choose one of the following:
   - **SKED 3.0 Server where it originated**: In this case, the crew members can be matched with the original crew member IDs and the crew listings remain intact. If one or more of the crew members no longer exist, errors may occur and you will need to select the external option. NOTE: You cannot use this option if you deleted the SQL database or had to reinstall SQL Server.
   - **An external SKED 3.0 Server**: Since the crew members will not be identical as the original server, the crew member names/assignments cannot be restored from this backup. This is the safest mode for restoring a workcenter, but will result in the loss of the maintenance responsibility assignments.
10. Click Next. The Review Selections dialog box appears.
11. If you are satisfied with the selections, click Finish. If you are not satisfied, click Previous and make any necessary changes.
12. A dialog box appears indicating that your workcenter is restored.
13. Click OK.
WHEN TO RESTART THE CYCLE

OPNAVINST 4790 and TYCOM directives dictate when ships should restart their cycles. Restarting the cycle is performed by the Department Head or 3MC allows them to reset the workcenter to a specific quarter. Cycles are reset for the following reasons:

- Major overhaul
- Conversion
- Construction

Before restarting your cycle, you should archive all old quarters. Once the cycle is restarted any previously active boards will be lost if not archived.

ADDITIONAL RESOURCES

Ship’s 3M Manual,
OPNAVINST 4790C
CHAPTER 13:
CONVERT 2.1 WORKCENTERS

UNDERSTANDING CONVERTING WORKCENTERS

Some users will be converting from SKED 2.1 to SKED 3.1. Those users will have to convert their old workcenters into SKED 3.1.

To convert 2.1 workcenters to SKED 3.1:

1. Log in to SKED 3.1.
2. On the File menu, click Convert 2.1 Workcenter. The Conversion Wizard dialog box appears.
3. Click “Yes, I want to convert a workcenter!” The Select Workcenter dialog box appears.
4. Click Browse. The Open dialog box appears. Browse to the 2.x workcenter and click the workcenter you wish to convert. Typically this file will be in the SKED 2 folder.
5. Click Open. The Select Workcenter dialog box should now read something like this: C:\Sked 2\CE01.wck. An Invalid Start Quarter Date dialog box may appear. If so, click OK, and remember to adjust your quarter dates once you have completed the conversion.
6. Click Next. The Select Owner Information dialog box appears.
7. From the Division drop down menu, select the Division.
8. From the Workcenter Supervisor list, select the Workcenter Supervisor.
9. Click Next. The Assign Crew Members dialog appears.

   NOTE: You may assign crew members now or do it later. However, if you do it later, all SKED 2 users will be deleted and replaced with “Unassigned.”

10. If you have already added your crew members to SKED 3.1, you can replace the SKED 2 users by selecting the name you want to replace and clicking Assign Crew Member. The Select User dialog box appears.
11. Click the desired SKED 3.1 user from the list and click OK. The old SKED 2 user has been replaced with the new SKED 3.1 user.
12. Once all assignments are made, click Next. The Convert EGLs dialog box appears if EGLs are contained in the workcenter.
13. Click the EGL in the SKED 2.1 column that you wish to assign a SKED 3.1 MRC.
14. Click Assign EGL. The Associate SKED 2.1 EGL Data dialog box appears.
15. Click the EGL you wish to assign and Click OK. Repeat steps 12 and 13 as many times as needed. Click Next when all MRCs have been assigned. The Review Selections dialog box appears.

   NOTE: If you wish to unassign an EGL, click the EGL you wish to unassign and click Unassign EGL.

16. Verify that all information is correct.
17. If you are satisfied, click Finish. If you are not satisfied, click Previous and make any necessary changes.